
Contents
Press F1 for assistance on Help. For additional assistance, contact Technical Support.

Menu commands

Step-by-step procedures

Maps of screen elements

Learning Asymetrix Digital Video Producer

Video and sound concepts

Using DVP Capture (Contents)

Menu commands
Click a menu name below for more information.

           File menu  
           Edit menu  
           View menu  
           Effects menu  
           Video menu  
           Palette menu  
           Tools menu  



Menu commands
Click a menu name below for more information.

           File menu  
New Project
Open Project
Save Project
Save Project As
Import Media
Remove Media
Media Statistics
Print To Screen
Scaling
Exit

           Edit menu  
           View menu  
           Effects menu  
           Video menu  
           Palette menu  
           Tools menu  



Menu commands
Click a menu name below for more information.

           File menu  
           Edit menu  
Undo
Cut
Copy
Paste
Duplicate

           View menu  
           Effects menu  
           Video menu  
           Palette menu  
           Tools menu  



Menu commands
Click a menu name below for more information.

           File menu  
           Edit menu  
           View menu  
Zoom In
Zoom Out
Set Range
Display All Tracks
Display Current Track Only
Timeline Options
Player Options

           Effects menu  
           Video menu  
           Palette menu  
           Tools menu  



Menu commands
Click a menu name below for more information.

           File menu  
           Edit menu  
           View menu  
           Effects menu  
Filters
Transitions
Audio Level
Titling
Overlay Options

           Video menu  
           Palette menu  
           Tools menu  



Menu commands
Click a menu name below for more information.

           File menu  
           Edit menu  
           View menu  
           Effects menu  
           Video menu  
Preview
Build
Output Format
Video Compression
Play Last Built
Audio Cross-Fade

           Palette menu  
           Tools menu  



Menu commands
Click a menu name below for more information.

           File menu  
           Edit menu  
           View menu  
           Effects menu  
           Video menu  
           Palette menu  
Edit Palette
Create Palette
Import Palette
Export Palette
Copy Palette From Project
Copy Palette From Selection
Paste Palette

           Tools menu  



Menu commands
Click a menu name below for more information.

           File menu  
           Edit menu  
           View menu  
           Effects menu  
           Video menu  
           Palette menu  
           Tools menu  
Capture Video
Bitmap Editor
Options



Step by step procedures
Click a topic to see step-by-step instructions for working with Asymetrix Digital Video Producer.

Adding a clip to the timeline
Adding and editing titles
Building a video
Capturing video
Capturing video using an MCI-controllable device
Copying a clip
Copying a palette
Creating an optimal palette
Editing a palette
Exporting a palette
Importing a palette
Importing media
Marking a clip section
Modifying a transition
Moving a clip on the timeline
Playing a clip
Playing your built video
Previewing a video
Removing a transition effect
Saving a project
Sending your video to someone
Starting a new project



Using DVP Capture (Contents)
Online Help for DVP Capture. Click the topic that you want to know more about.

To use DVP Capture, a video capture board must be installed and configured in your system.

Step by step procedures
Capturing video
Capturing video using an MCI-controllable VCR device

Maps of screen elements
DVP Capture window

Menu commands
           File menu  
           Edit menu  
           Options menu  
           Capture menu  



Using DVP Capture (Contents)
Online Help for DVP Capture. Click the topic that you want to know more about.

To use DVP Capture, a video capture board must be installed and configured in your system.

Step by step procedures
Capturing video
Capturing video using an MCI-controllable VCR device

Maps of screen elements
DVP Capture window

Menu commands
           File menu  
Load Palette
Set Capture File
Allocate File Space
Save Captured Video As
Save Palette
Save Single Frame
Exit

           Edit menu  
           Options menu  
           Capture menu  



Using DVP Capture (Contents)
Online Help for DVP Capture. Click the topic that you want to know more about.

To use DVP Capture, a video capture board must be installed and configured in your system.

Step by step procedures
Capturing video
Capturing video using an MCI-controllable VCR device

Maps of screen elements
DVP Capture window

Menu commands
           File menu  
           Edit menu  
Copy
Paste Palette

           Options menu  
           Capture menu  



Using DVP Capture (Contents)
Online Help for DVP Capture. Click the topic that you want to know more about.

To use DVP Capture, a video capture board must be installed and configured in your system.

Step by step procedures
Capturing video
Capturing video using an MCI-controllable VCR device

Maps of screen elements
DVP Capture window

Menu commands
           File menu  
           Edit menu  
           Options menu  
Audio Format
Video Format
Video Source
Video Display
Compression
Preview Mode
Overlay Mode

           Capture  



Using DVP Capture (Contents)
Online Help for DVP Capture. Click the topic that you want to know more about.

To use DVP Capture, a video capture board must be installed and configured in your system.

Step by step procedures
Capturing video
Capturing video using an MCI-controllable VCR device

Maps of screen elements
DVP Capture window

Menu commands
           File menu  
           Edit menu  
           Options menu  
           Capture menu  
Single Frame
Frames
Video
Palette
Settings



File menu



New Project
File menu

Keyboard: Ctrl+N

Closes the current project, prompting you to save changes if necessary, and clears the timeline to start a new 
project.



Step by step
Starting a new project
Commands
Open Project



Open Project
File menu

Keyboard: Ctrl+O

Toolbar:

Opens an existing DVP project file. Only one project file can be open at a time.

Option Description
File Name Lists files in the current DVP directory. Select or enter the name of a project file to open. 

Clicking OK opens the selected file.
List Files Of Type Indicates .PRJ as the default file extension.
Directories Displays the current directory and path. Change the directory by selecting a new path from 

the Directories box, which lists all directories available on the current drive. To change the 
drive, make a selection in the Drives box.

Drives Lists the available drives. Selecting a different drive changes the contents of the Directories 
box.



Save Project
File menu

Keyboard: Ctrl+S

Saves the contents of the timeline and Media Window to the current project file. If the current project has never 
been named and saved, DVP opens the Save Project As dialog box.



Step by step
Saving a project



Save Project As
File menu

Saves the contents of the timeline and Media Window with a DVP project name you specify.

Option Description
File Name Specifies the name under which the project file will be saved. Clicking OK saves the file with 

the .PRJ extension.
List Files Of Type Indicates .PRJ as the default file extension.
Directories Displays the current directory and path. Change the directory by selecting a new path from 

the Directories box, which lists all directories available on the current drive. To change the 
drive, make a selection in the Drives box.

Drives Lists the available drives. Selecting a different drive changes the contents of the Directories 
box.



Step by step
Saving a project



Import Media
File menu

Toolbar:

Imports any media file (.AVI, .BMP, .DIB, .FLC, .  FLI  , .GIF, .PCX, .TGA, .TIF, or .WAV file) that you want to include 
in your project.

Option Description
File Name Lists all the files in the current default directory. Select or enter the names of media files you 

want to import. Drag to select more than one file, or press Ctrl and click the files you want to 
import. Clicking OK adds the selected file or files to the Media Window.

List Files Of Type Indicates the default file extension.
Directories Displays the current directory and path. Change the directory by selecting a new path from 

the Directories box, which lists all directories available on the current drive. To change the 
drive, make a selection in the Drives box.

Drives Lists the available drives. Selecting a different drive changes the contents of the Directories 
box.

Preview Previews the selected .AVI or .WAV media file. If you are previewing an .AVI file, click the 
Play button after clicking Preview.



Step by step
Importing media



Remove Media
File menu

Removes the selected media file from the Media Window and timeline. If no media file is selected in the Media 
Window, the command is unavailable.



Media Statistics
File menu

Displays information about the media file selected in the Media Window. If no media file is selected, the command 
is unavailable.
Note You can also double-click a media file in the Media Window to open the Media Statistics dialog box.

Option Description
File Indicates general file information.

Name. File name and location.
Media Type. Type of media file: Video, Audio, Video and Audio, or Image.
Length. Number of frames in the media file.
Frame Rate. Number of frames displayed each second when you play back a video, expressed in 

frames per second (fps). The more frames that appear per second, the better the quality of the video.
Video Indicates video characteristics.

Frame Size. Size of the frame in pixels.
Compression. Method used to make the video data more compact, or compressed, so that it 

requires less space on a hard disk.
Format. Bit depth of the video or image file.

Audio Indicates audio characteristics. 
Type. Kind of waveform file (.WAV or .PCM).

Frequency. Number of audio samples per second, expressed in hertz (Hz), in the audio file. The 
higher the frequency, the better the sound quality.

Channels. Mono or Stereo. Mono plays the same audio through both speakers; Stereo plays the 
audio in two separate channels.

Sample Size. Amount of data in each sample in the audio file: 8-bit, 16-bit, or 24-bit. Many 
desktop applications use 8-bit sampling; 16-bit sampling offers CD-quality sound.



Print To Screen
File menu

Hides DVP and plays the .AVI file selected in the Media Window on your computer screen. (This command doesn't
play back other file formats.)

Option Description
Output Size Frame size at which the video plays: 100% plays the video at its original size; 200% plays 

the video at twice the original size; and Full Screen plays it at maximum size.
Loop Playback Specifies that the video automatically plays again.
Blank Screen Specifies the number of seconds the screen is blank between each repetition when Loop 

Playback is checked.
Start Starts the video using options you set.



Scaling
File menu

Scales or crops the selected media file to fit the final frame size of your video. This command is only available 
when a media file is selected in the Media Window.

Option Description
Stretch Video To 
Output Size

By default, scales the selected media file to fit the final frame size of 
the video file you're building. If the aspect ratios between the 
selected media file and the final video file differ, DVP stretches the 
selected media file to fit the output dimensions.

Crop Video To 
Output Size

DVP includes the selected video in the final video file at its original 
frame size, rather than scaling it larger or smaller to fit the final frame
size. If the frame size of the selected video is larger than the frame 
size of the final video, part of the video image is cropped. 

Cropping Expands the Scaling dialog box to display cropping controls, so you 
can determine how the selected video is cropped. Available only 
when Crop Video To Output Size is selected.

Drag Outline To 
Place Video

Specifies how the selected media file appears in the final video file. If
the selected media file is smaller than the final video file, dragging 
the outline positions the file against a black background. If the 
selected media file is larger than the final video file, dragging the 
outline determines what portion of the image appears in the final 
video and what is cropped.

Current Position Specifies the position, in pixels, of the upper-left corner of the 
selected media file in relation to the upper-left corner of the final 
video file. Enter new coordinates to change the position of the 
selected media file. These coordinates also reflect changes in 
position when you drag the outline.



Exit
File menu

Keyboard: Alt+F4

Closes DVP, prompting you to save changes to the current project file if necessary.



Edit menu



Undo
Edit menu

Keyboard: Ctrl+Z

Reverses the last edit you made on the timeline. If the action cannot be undone, this command is unavailable.



Cut
Edit menu

Keyboard: Ctrl+X

Toolbar:

Removes the selected clip or overlay from the timeline and temporarily places it on the DVP clipboard.
If a portion of a media file is selected on the timeline, only the selected portion is removed. The remaining portion 
either stays in place or moves to where the cut portion started, depending on the Cut/Paste option selected in the 
Options dialog box.
The media file or overlay that you cut remains on the DVP clipboard and can be pasted onto the timeline until you 
cut or copy another media effect or overlay.
Note DVP does not use the Windows Clipboard, so you cannot cut or copy anything to, or paste anything from, 
another Windows program.



Step by step
Copying a clip
Commands
Copy
Duplicate
Paste



Copy
Edit menu

Keyboard: Ctrl+C

Toolbar:

Copies the selected clip or overlay from the Media Window or timeline and temporarily places it on the DVP 
clipboard. If a portion of a clip is selected on the timeline, only the selected portion is copied. The clip or overlay 
that you copy remains on the DVP clipboard and can be pasted onto the timeline until you cut or copy another clip 
or effect.

Note DVP does not use the Windows Clipboard, so you cannot cut or copy anything to, or paste anything from, 
another Windows program.



Step by step
Copying a clip
Commands
Cut
Duplicate
Paste



Paste
Edit menu

Keyboard: Ctrl+V

Toolbar:

Pastes a copy of a clip or overlay that you cut or copied onto the timeline.
When you paste a clip into an area of the timeline already occupied by another clip, the clip you paste is either 
inserted into the existing one or overwrites it, depending on the Cut/Paste option selected in the Options dialog 
box.
Note DVP does not use the Windows Clipboard, so you cannot cut or copy anything to, or paste anything from, 
another Windows program.



Step by step
Copying a clip
Commands
Copy
Cut
Duplicate



Duplicate
Edit menu

Duplicates a clip or overlay you cut or copied to the DVP clipboard, and pastes one or more copies of it 
consecutively along the selected timeline track. Creates as many copies as you specify. The default is one.

This command is particularly useful for duplicating a bitmap across several frames.



Step by step
Copying a clip
Commands
Copy
Cut
Paste
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Zoom In
View menu

Keyboard: Numpad +

Toolbar:

Magnifies the timeline to display fewer frames or a smaller portion of audio at one time. 



Commands
Display All Tracks
Display Current Track Only
Set Range
Zoom Out



Zoom Out
View menu

Keyboard: Numpad -

Toolbar:

Reduces the view of the timeline to display more frames or a larger portion of audio at one time.



Commands
Display All Tracks
Display Current Track Only
Set Range
Zoom In



Set Range
View menu

Keyboard: Ctrl+R

Determines the start and end frames, and the total number of frames to display in a range on the timeline. You can
display the current range, or set a new range.

Option Description
Start First frame in the range to display.
End Last frame in the range to display.
Total Total number of frames to display.



Commands
Display All Tracks
Display Current Track Only
Zoom In
Zoom Out



Display All Tracks
View menu

Toolbar:

Displays all six tracks (Video A, Video B, Trans, Overlay, Audio A, Audio B) of the timeline simultaneously, so you 
can see how the media clips are arranged in relation to one another.



Commands
Display Current Track Only
Set Range
Zoom In
Zoom Out



Display Current Track Only
View menu

Toolbar:

Displays only the timeline track that currently contains the cursor, so you can work with the clip on that track more 
easily.
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Timeline Options
View menu

Determines how DVP displays thumbnail views of video and audio frames on the timeline. When you select Paint 
Video Frames or Paint Audio Frames, DVP displays each video frame and all of the sound wave, so you can more 
easily identify a section. When these options are unchecked, DVP displays only the first and last thumbnails in the 
currently visible range, so the timeline scrolls more quickly.

Option Description
Paint Video Frames Displays thumbnails of each video frame on the timeline. When unchecked, the timeline 

displays only the first and last thumbnails of the visible range.
Paint Audio Frames Displays thumbnails of all the audio information on the timeline. When unchecked, the 

timeline contains placeholders instead of thumbnails.
Show As Frames Displays frames as the unit of measure on the timeline tick bar.
Show As Time Displays time as the unit of measure on the timeline tick bar.



Player Options
View menu

Displays either or both Players, and sets the size at which each displays video, animation, and graphic clips.

Option Description
Visible Makes the Player visible in the DVP window.
Zoom Size Specifies whether the Player displays a media clip at its specified 

frame size, at 25% or 50% of its size, or at twice its size (up to a 
maximum size of 320 by 240 pixels). The Player window doesn't 
change size until you drag a media clip into it.

Play Video Using 
DVP Palette

Plays media clips in the Players using the DVP palette. This option
eliminates potential palette shift when you use the Players, but 
does not affect the palette of the final video you build.

Play Clip 
Automatically

Plays a video or audio clip automatically when you drag it onto the
Player window. When unchecked, you must click the Play button 
(or another navigational button) to preview the clip.



Step by step
Playing a clip



Effects



Filters
Effects menu

Applies one or more filters to the portion of your video on the timeline.

Option Description
Filters Lists all available filters. Click a filter to select it.
Description Describes the filter currently selected in the Filters list.
Add Adds the selected filter to the Selected list.
Remove Removes the selected filter from the Selected list.
Selected Displays the filters that you've added from the Filters list. (Clicking OK then applies those filters.)
Options Expands the Filters dialog box to display the Filter Options area and a preview window.
Preview Previews the video with the filter options you set.



Concepts
About filters



Transitions
Effects menu

Displays the transition effect currently selected on the Trans track on the timeline. You can then change that 
transition to another transition, or, for some transitions, edit how the transition works. If no transition effect is 
selected, this command is unavailable.
Note When you overlap two media clips on the Video A and Video B tracks, DVP automatically creates a Dissolve 
transition. 

Option Description
Transitions Lists all available transitions. Click a transition to select it.
Description Describes the transition currently selected in the Transitions list.
Selected Displays the selected transition. (Clicking OK then applies that transition.)
Options Expands the Transitions dialog box to display the Transition Options area and a preview 

window.
Preview Previews the video with the transition you set.



Concepts
About transitions



Audio Level
Effects menu

Changes the volume of the audio in the selected portion of an audio track.
Use this command to create cross-fades, such as when you want to fade background music during a voiceover.

Option Description
Beginning Level Sets the volume at the beginning of the selection. You can also drag the left point on the 

volume indicator to set the beginning volume level.
Ending Level Sets the volume at the end of the selection. You can also drag the right point on the volume 

indicator to set the ending volume level.



Titling
Effects menu

Creates titles for your project, so you can include names, descriptions, and other text effects in your video files. If 
you select a range of frames on the tick bar or on any timeline track (except Overlay) before choosing this 
command, DVP opens the Titling dialog box directly. If you choose this command without specifying a range of 
frames, DVP first opens the Title Frames dialog box, so you can specify the frames your title covers.
Note When you create a title for a project, DVP places it on the Overlay track in the location you specify. If any 
other title or overlay occupies the same spot on the track, DVP replaces it with the new title. To add several 
overlays and titles in the same location, you must create multiple builds.

Option Description
Titles For Selected 
Frames

Lists the current titles.

Edit Title Displays the area in which you enter a new title or edit a title 
selected in the Titles For Selected Frames box.

Start Frame Shows the first frame in the range you selected on the timeline or 
specified in the Title Frames dialog box. Change the starting frame 
by entering a new frame number.

End Frame Shows the last frame in the range you selected on the timeline or 
specified in the Title Frames dialog box. Change the ending frame 
by entering a new frame number. 

Total Frames Shows the range of frames that will contain a title (initially, the 
range of frames selected on the timeline). Change the range by 
entering a new number. 

Path Opens the Path dialog box, in which you specify options for moving,
zooming, and rotating the title. This button is available when you 
select a title in the Titles For Selected Frames list. 

Delete (button) Removes selected text without placing a copy on the Windows 
Clipboard. 

Color (button) Opens the Color dialog box, in which you specify the text color.
Font (button) Opens the Font dialog box, in which you select type specifications 

to apply to the type in a selected title.



Commands
Path (dialog box)



Title Frames (dialog box)
Effects menu/Titling

Specifies the range of frames that the title will cover in your video file. This dialog box opens only if you do not 
select a range of frames on the timeline before choosing the Titling command.

Option Description
Start Of Title Enter a frame number to specify where the title begins.
Length Of Title Enter a frame number to specify the length of the title.



Path (dialog box)
Effects menu/Titling or Overlay/Path

Customizes the path a title or overlay follows when it appears in your video file. Use this dialog box to set options 
that move, zoom, and rotate the title or overlay.

Option Description
Path (point) Determines the path of the title or overlay. Specify how and where the title or overlay 

moves by clicking a series of points in the dialog box. If you add two or more points, the 
title or overlay moves smoothly from one point to the next. To produce the effect of 
moving a title or overlay on- or offscreen, position points outside the preview thumbnail.
Note By default, a title or overlay is centered in the video frame.

Options Expands the dialog box to display the path options area, where you set path 
characteristics, such as how a title or overlay moves, changes size, and rotates.

Points (buttons) Adds a point to the path or removes a selected point from the path. Adds a point on top 
of the selected point; you then drag the new point to a different location to position it.

Add Specifies whether points are added before or after the selected point.
Uniform Points Distributes all points equally over time. If you add a new point or increase the time a 

selected point occupies, the timing of each point is adjusted so that the title or overlay 
still occupies the same amount of time. When unchecked, if you add a new point or 
increase the Get Here or Wait Here values, DVP removes an equal number of frames 
from the end of the title or overlay sequence. For details about Get Here and Wait Here, 
see below.

Set Object Rotation Sets the rotation of the selected point. The title or overlay then rotates smoothly from one
position to the next as it moves from one point to another point to which you've applied a 
different rotation.

Set Object Size Sets the size of the title or overlay (in pixels) at the selected point on the path. The title or
overlay then transforms smoothly from one size to the next as it moves from one point to 
another point to which you've applied a different size.

Get Here Sets the number of frames between the previous point and the selected one. Increasing 
the number causes the title or overlay to move more slowly; decreasing the number 
causes it to move more quickly.

Wait Here Sets the number of frames the title or overlay should remain at a point before moving on 
to the next. Enter the number of frames to wait.

Preview (buttons) Steps backward or forward through the titling or overlay sequence. Click to move to the 
beginning or end of the title or overlay, step through one point at time; or step through 
one frame at a time.

Video Sets the video thumbnail to display as a dotted outline or as actual frames from the 
video. You set the display by selecting Preview Outline or Preview Image. Displaying an 
outline lets you review a title or overlay sequence more quickly, while displaying the 
video frames helps you coordinate the titling or overlay action with the action in the 
video.

Overlay Sets the overlay thumbnail to display as the actual title or overlay, as a dotted outline, or 
as a point. You set the display by selecting Preview Image, Preview Outline, or Preview 
Point. Preview Image provides the most detail about how the title or overlay will appear 
in your video; Preview Outline shows the size, position, and rotation of the title or 
overlay; Preview Point indicates only the location of the title's or overlay's center.



Overlay Options
Effects menu

Sets how graphics and video files overlay sections of your video. To create an overlay, you place a bitmap, video, 
or animation clip on the Overlay track, then open this dialog box to set keying options. 
Keying determines what portion of the overlay is transparent and what portion appears in the final video file. DVP 
includes controls for fine-tuning how graphics overlay your video, as well as options for previewing the effect of 
your settings and setting a path for the overlay to travel.

Option Description
Key Color (Red, 
Green, Blue)

Displays the key color for the overlay. You specify the color you 
want by entering red, green, and blue (RGB) values, or by 
clicking a color area in the preview window.

Alpha Shows the degree of the overlay's transparency. Adjust the 
Alpha value, then view the effects in the preview window.

Tolerance Shows the acceptable deviance from the specified color that will
be keyed. Tolerance allows colors within a specified range to 
key correctly. For solid backgrounds, such as those in a bitmap 
or animation, adjusting tolerance may not be necessary. For 
backgrounds that vary slightly in color, such as a live video that 
includes tints of a single color (as in shadow areas), adjust the 
Tolerance value, then view the effects in the preview window.

Preview Displays the current frame in the overlay; by clicking the scroll 
bar buttons, you can proceed through the key frames one frame
at a time.

Preview Tracks Specifies which tracks are displayed in the preview window: the 
video tracks, the Overlay track, or both. To view the Overlay 
track keyed onto the video track, click Both.

Path Opens the Path dialog box, in which you specify options for 
moving, zooming, and rotating the overlay.

Update When clicked, displays the effects of the current settings in the 
preview window.



Commands
Path (dialog box)



Video



Preview
Video menu

Keyboard: Ctrl+P

Previews the current contents of all tracks on the timeline.

Option Description
Play button Plays the video. When you click the Play button, it turns into a Pause button, which you 

can click to pause the video.
Scroll bar Scrolls forward or backward through the frames of video.



Build
Video menu

Toolbar:

Compiles all the media clips you placed on the timeline into a video file that you can play or import into an online 
multimedia piece. The final video file includes any editing decisions you made as you laid out the video. 
After you set options in this dialog box, click Build to start the build process. Depending on the size and complexity
of the media files, the effects you've applied, and the options you've set, the build process may require a 
significant amount of time. DVP displays the build progress in a preview window.
Note Specify compression and output format options before you build your video file.

Option Description
File Name 
box

Displays the name (up to eight characters) and location for the new video 
file. Enter the name and location of your video file. Or click Browse to find 
another location or an existing file that you want to overwrite.

Title Adds a secondary title to your video and stores it in the .AVI file. DVP and 
other programs that work with .AVI files can display the title. 

Description Adds a description to the video file information, so you can note more 
details about that file than the eight-character name can convey. Useful 
when you're building similar versions of a video file. Appears in the Media 
Window if you import the video file back into DVP. 

Compress 
All

Compresses all frames on the timeline, no matter what compression 
method has previously been applied. When unchecked, DVP only re-
compresses frames that have changed. (Changes include edits such as 
resizing or cropping frames or applying filters and other special effects.) 
Note Compressing only changed frames helps speed compression and 
can improve image quality. However, if you make global changes to a 
video, such as changing the frame rate, you should check Compress All. 

Warn On 
Data Rate 
Failure

Warns if the video you are building exceeds the compression data rate 
specified in the Video Compression dialog box. Use this option when you 
need to keep the data rate of the video file below the data rate the video 
playback system can support. For example, if your video will be played 
back from a CD-ROM drive, you should limit the data rate to one a typical 
CD-ROM can support. 

Use Project 
Palette

Specifies that DVP uses the palette you generated, imported, or copied 
and pasted into the project file as the final video file palette. Creating and 
using a project palette to build the video file helps prevent palette shift in 
the video file. 

Use Source
Palette

Specifies that DVP builds the video file using the individual palettes 
associated with each frame or clip on the timeline. Choosing this option 
makes building the video faster, but may also produce palette shifts when 
you play it back.

Use 
Optimal 
Palette

Specifies that DVP creates an optimal palette for an 8-bit video file as it 
builds that file. To create this palette, DVP examines the colors in every 
frame on the timeline, which can slow down the build process 
considerably. However, this option helps prevent palette shift in the final 
video file. 

Note Palette options (Use Project Palette, Use Source Palette, and Use Optimal Palette) are relevant only to 8-bit 
output video because video and graphics with bit depths greater than 8 bits do not use palettes. DVP ignores the 
palette options if you set the Output Format to a bit depth greater than 8 bits.





Commands
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Output Format
Step by step
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Concepts
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Compression tips



Output Format
Video menu

Sets the final characteristics of your video file, including frame size, bit depth, and frame rate. You set these 
characteristics before choosing the Build command to build the video file. 

Option Description
File Format Sets the file format DVP uses to build the project file: .AVI (the 

default format), .WAV, or video-only .FLI or .FLC files. DVP can 
also build a series of bitmaps in .BMP, .DIB, .PCX, .TGA, .TIF, 
and .GIF formats. 

Size Sets the final video frame size in pixels. Common frame sizes 
for .AVI files are 160 by 120 pixels and 320 by 240 pixels. To 
change the frame size, enter new values for the width and 
height.

Bit Depth Sets the bit depth of your video to 8 bit, 16 bit, or 24 bit. The 
higher the bit depth you choose, the more realistic the color but 
the larger the video file size. 

Frame Rate Sets the number of frames per second (fps) for your final video. 
Higher frame rates, up to 30 fps, provide smoother motion, but 
also result in larger video files. Lower frame rates, such as 8 
fps, use less data but create jerky motion. .AVI files are often set
to 15 fps, which provides a relatively smooth sense of motion.

Maintain Frame 
Numbers

Maintains the number of frames in each video sequence on the 
timeline, rather than adding or dropping frames to reconcile 
different frame rates. If, for example, you're building a video file 
to play at 20 frames per second, but the project contains a 
segment that plays at 10 frames per second, DVP will maintain 
the number of frames in that segment but build them to play 
twice as fast. 
Choose this option when you edit video files that have the same
frame rates because DVP then never drops frames or adds 
additional frames. However, don't select this option when you 
use video files that contain audio and have different frame rates.
Audio is time-dependent, so altering the speed at which the 
video frames display causes the video and audio to be out of 
sync. In this case, choose Synchronize Video instead.

Synchronize Video Adds or drops video frames as necessary to reconcile different 
frame rates to the final frame rate. Choose to ensure that the 
audio remains synchronized at the new frame rate. You can also
use this option to create slow-motion and fast-motion effects.

Pad Output Video For 
CD-ROM Playback

Creates a video file that's optimized to play efficiently from a 
CD-ROM. Check this option if your video file will be distributed 
on a CD-ROM.

Channels Specifies Mono or Stereo. Mono plays the same audio through 
both speakers; Stereo plays the audio in two separate channels.

Sample Size Specifies the amount of audio data to include in each sample. A 
16-bit sample produces the best sound, but larger files.

Frequency Specifies the frequency with which the sound is sampled per 
second. Higher sample rates produce better quality sound, but 
larger files.

Interleave Audio Every Specifies how often to interleave audio information with frames 
of video. The default is every frame, which produces excellent 
results. You can experiment with different settings to ensure that



the mix of audio and video isn't choppy.
Note If you choose Pad Output Video For CD-ROM Playback, 
DVP automatically sets this option to 1 frame to give you the 
best results for CD-ROM playback. You cannot edit this setting 
unless you uncheck Pad Output Video For CD-ROM Playback.

Use Format From First 
Video Input

Specifies that every video clip you place on the timeline uses 
the same frame rate, frame size, and compression rate as the 
first video clip you place on the timeline. When unchecked, each
video clip you place on the timeline uses the default settings for 
these options (unless you specify new settings). The default 
settings are: 160 by 120 pixels (frame size), 15 fps (frame rate), 
and MS Video 1 (compression). 



Step by step
Building a video
Concepts
About sound



Video Compression
Video menu

Specifies the compressor DVP uses to reduce the size of the final video file. Compressing video files involves 
making tradeoffs between final file size and playback quality. When you choose a compressor, you also set options
that affect how the compressor works. For example, you may direct the compressor to favor making smaller files 
over preserving quality, or vice versa. 

Option Description
Compressor Sets the compression/decompression routine used, called a codec. DVP includes several 

codecs, such as Microsoft Video 1, Cinepak, and Intel Indeo Video R3.2. If you have a 
video capture board, it may provide other codecs that also appear in this list.

Compression Quality Specifies the video compression quality. On a relative scale of 0 (more compression, lower
quality) to 100 (less compression, higher quality), you can control the tradeoff between 
quality and file size. Higher-quality video creates larger files and takes longer to compress.

Key Frame Every Specifies how often key frames are included in the final video. In general, a choice of one 
key frame for every 15 frames provides a good balance between quality and performance.

Data Rate Sets the data rate for the video file. As a rule, choose a data rate that corresponds to the 
data rate of the device that will play back the video file. Selecting the correct data rate 
ensures that the video file will play back well.
Note CD-ROM drives have low data transfer rates that make them much slower than a 
typical hard disk; if you plan to play back your video from a CD-ROM drive, limit the data 
rate to that of the CD-ROM drive.

Configure Displays additional configuration options for the selected compressor, if available.
About Displays version and copyright information about the compression method selected in the 

Compressor box.
Preview Previews the video after compressing it using the selected compression method.



Step by step
Building a video
Concepts
Compression tips



Play Last Built
Video menu

Toolbar:

Plays the most recently built video. This command is available only if you have built a video since you started the 
current session of DVP.



Audio Cross-Fade
Video menu

Automatically creates a transition between any two audio clips that overlap on the timeline, so the first audio clip 
fades out as the second one fades in. DVP creates this transition, called a cross-fade, when it builds the video file. 
When this command is unchecked, DVP mixes the end of the first audio clip with the beginning of the second 
audio clip at normal volume. 



Concepts
About sound



Palette



Edit Palette
Palette menu

Opens PalEdit, a utility you can use to modify any color in an 8-bit palette; adjust the brightness, contrast, or tint of
any color; or reduce the number of colors in the palette. When you close PalEdit, DVP prompts you to save or 
discard the changes you made to the project palette.
Available only if your project has a project palette. To create a project palette, you can create, import, or copy and 
paste a palette. 
For more details on using PalEdit, refer to the PalEdit online Help system. 



Commands
Copy Palette From Selection
Create Palette
Import Palette
Paste Palette
Concepts
About color palettes



Create Palette
Palette menu

Creates an optimal 8-bit palette using all of the frames placed on the timeline or a selection of frames you specify. 
You create an optimal color palette to prevent palette shifts in your 8-bit .AVI files. 
After you specify which frames should be analyzed to create the palette, DVP displays the Palette Optimization 
Progress dialog box, so you can monitor the palette's creation. Once DVP generates the palette, that palette 
automatically becomes the project palette. However, it doesn't alter the media clips on the timeline until you build 
the final video file. 

Option Description
Whole Video Uses all the clips on the timeline as the basis of an optimal 8-bit color palette.
Section Uses a range of frames as the basis of an optimal 8-bit color palette. Enter the beginning and 

ending frame numbers of the range you want.



Commands
Copy Palette From Selection
Edit Palette
Import Palette
Paste Palette
Concepts
About color palettes



Import Palette
Palette menu

Imports an 8-bit palette into a project and automatically replaces any other project palette you created or copied 
and pasted. After you import a palette, you can edit it to work optimally with the video file you're building. 

Option Description
File Name Select or enter the name of an available palette file to open.
List Files Of Type Indicates .PAL as the default file extension.
Directories Displays the current directory and path. Change the directory by selecting a new path from 

the Directories box, which lists all directories available on the current drive. To change the 
drive, make a selection in the Drives box.

Drives Lists the available drives. Selecting a different drive changes the contents of the Directories 
box.



Commands
Copy Palette From Selection
Create Palette
Edit Palette
Paste Palette
Concepts
About color palettes



Export Palette 
Palette menu

Saves an 8-bit project palette as an independent palette file with a .PAL extension. After you export an 
independent color palette, you can apply that palette to other 8-bit graphics and video files.
Available only if your project has a project palette. To create a project palette, you can create, import, or copy and 
paste a palette.

Option Description
File Name Sets a file name of up to eight characters. When you click OK, the file is saved with the .PAL 

extension.
List Files Of Type Indicates .PAL as the default file extension.
Directories Displays the current directory and path. Change the directory by selecting a new path from 

the Directories box, which lists all directories available on the current drive. To change the 
drive, make a selection in the Drives box.

Drives Lists the available drives. Selecting a different drive changes the contents of the Directories 
box.



Commands
Copy Palette From Selection
Create Palette
Edit Palette
Paste Palette
Concepts
About color palettes



Copy Palette From Project
Palette menu

Copies an 8-bit project palette to the Windows Clipboard, so you can paste it into other programs such as PalEdit 
or Adobe Photoshop. 
Available only if your project has a project palette. To create a project palette, you can create, import, or copy and 
paste a palette.



Commands
Copy Palette From Selection
Create Palette
Edit Palette
Paste Palette
Concepts
About color palettes



Copy Palette From Selection
Palette menu

Copies an 8-bit palette from a frame of video, so you can paste it into the project as the project palette. Offers a 
quick way to create and apply a single palette to simple video or animation files.
Available only if you select an 8-bit video frame, or a series of frames that share a common palette. You must 
paste it into the project to create the project palette.



Commands
Copy Palette From Project
Create Palette
Edit Palette
Paste Palette
Concepts
About color palettes



Paste Palette
Palette menu

Pastes the 8-bit palette that you copied from a frame (or from a set of frames that share a palette) into the current 
project. 
Available only if you've copied a palette from a selection.



Commands
Copy Palette From Selection
Edit Palette
Concepts
About color palettes



Tools



Capture Video
Tools menu

Opens DVP Capture, which you use to capture video from a VCR, video camera, or videodisc player.
Important To open DVP Capture, you must have installed and configured a video capture board in your system.



Bitmap Editor
Tools menu

Opens BitEdit, a utility that you can use to edit bitmap graphics. For details on how to use BitEdit, refer to the 
BitEdit online Help system.



Options
Tools menu

Sets options for editing clips on the timeline. The setting you choose appears on the Cut and Paste indicators on 
the bottom-left corner of the timeline.

Option Description
Delete/Insert Sets the following behavior when you cut or paste elements from the timeline: When you cut 

part of a clip from the timeline, moves the section of the clip that follows it over to occupy the
same space with no gap. When you paste one clip on top of another, moves the clip 
underneath to follow the clip you pasted.

Erase/Overwrite Sets the following behavior when you cut or paste elements from the timeline: When you cut 
a portion of a clip from the timeline, removes that portion without affecting the other 
segments. When you paste a clip on top of another clip, the clip underneath does not 
change position; and only the portion that extends beyond the end of the clip you paste will 
play.

Snap Cuts To End Automatically snaps a clip dragged from the Media Window onto a timeline track to the end 
of the last clip on that track. Use this option to position clips quickly and accurately. Uncheck 
it when you need more control over positioning your clips on the timeline. (Any time you 
position a clip on the timeline, however, you can subsequently drag the clip to a new 
position, or cut and paste it.)



Glossary
Click a letter to display glossary entries.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A
analog audio
analog video
animation
anti-aliasing
aspect ratio
audio
AVI

B
bit depth
bitmap
BMP
build

C
CD audio
CD-ROM



chroma-key
Cinepak
clip
clip media
clipboard
codec
compression
cross-fade

D
data rate
delete (segment)
device driver
device-independent
DIB
digital audio
digital video
digitize
display device
dithered
drag
DVI
DVP
DVP Capture

E
edit points
8-bit (color)
erase (segment)

F
filter
FLI/FLC
font
fps (frames per second)
frame
frame rate
frame size
frequency

G - I
GIF
high-color
image
in point
Indeo

J - L
JPEG
key
key color
key frame
keying
Kodak Photo CD
lossless
lossy

M



marking
MCI (Media Control Interface)
media device
media device channel
media file
media source
Media Window
MIDI
MPEG
multimedia

N - O
nonlinear editing
NTSC
optimize
optimization
out point
overlay
Overlay track

P
PAL (Phase Alternation by Line)
palette
palette shift
PCX
pixel
play
Player
Point & Click
project

Q - S
QuickTime
RLE
sample
scale
scanning
SECAM
segment
smoothing
sound

T
TGA
thumbnail
tick bar
TIF
time code
timeline
title
track
transition effect

U - V
VCR
video
video capture
video capture board



Video for Windows
videodisc
VISCA
visual media clips
voiceover

W-Z
WAV (wave audio)
waveform
zoom



analog audio
The audio signal that comes from an analog audio source such as an analog audio tape recorder; or sound from a 
videotape player, videodisc player, camera, or television tuner. Unlike digital audio, which represents the audio 
information as bits, analog audio is created by the characteristics of electrical signals transmitted through one or more
wires. See also digital audio, videodisc.



analog video
The video signal that comes from an analog video source, such as a videotape player, videodisc player, camera, or 
television tuner. Unlike digital video, which represents the video information as patterns of bits, analog video is 
created by the characteristics of electrical signals transmitted through one or more wires. See also digital video, 
videodisc.



animation
A simulation of movement produced by displaying a series of successive images onscreen.
The two basic kinds of computer animation are frame and cast-based. Frame animation is created by designing a 
separate frame for each screen view, much like a separate individual frame of a filmstrip or videotape. Cast-based 
animation is created by individually designing all of the moving objects to be used through a series of frames; 
assigning each object its own character traits (such as position, pattern, size, and ink); then assembling a complete 
picture frame containing the individual objects. See also digital video.



anti-aliasing
When overlaying graphics or text, a method of blending the edges around the keyed areas. Also called smoothing.



aspect ratio
The relative width and height of a graphic or video window, without regard to its size. For example, a 2-inch by 4-inch 
graphic has the same aspect ratio as one that is 3 inches by 6 inches.



audio
Recorded sound, such as in a .WAV file, or the sound portion of an .AVI file.



AVI (Audio/Video Interleaved)
A format for storing digital video in a file that alternates blocks of visual and sound information. .AVI files are 
particularly suited for storing on CD-ROM, because their interleaved format lends itself to efficient retrieval with the 
techniques used on CD-ROM drives.



bit depth
The number of bits of color information stored for every video pixel. Standard values for video are 8-bit (up to 256 
colors), 16-bit (up to 65,536 colors, also called high-color), and 24-bit (up to 16.7 million colors, called true-color).



bitmap
An image composed of pixels. Bitmaps are typically used to reproduce images that contain detail, shading, and color, 
such as photographs and film images. You can create bitmaps by using DVP Capture, using paint software, or 
scanning photographs or flat art.



BMP
The Windows and OS/2 bitmap file format. Identical to .DIB.



build
The process of creating a new video in DVP using the video, sound, bitmaps, and effects assembled on the timeline.



CD audio
Compact disc audio (sometimes called Red Book audio) is sound that is stored digitally (as a series of binary values) 
and converted to analog (continuous sound) within the CD-ROM drive, then played back via the audio cable. 
Because the CD-ROM, and not your computer, converts the data from digital to analog, it does not limit the other 
actions the CPU can simultaneously perform. To use CD audio, you must have a CD-ROM drive and a CD audio 
device driver installed through the Windows Control Panel.



CD-ROM
Compact disc read-only memory.



chroma-key
A type of keying in which the transparency of a particular area is dependent on a key color that you specify. Used to 
superimpose portions of one image onto another, such as the image of a television weather reporter superimposed 
on a weather map.



Cinepak
A compression method designed by SuperMac Technologies and included with DVP. Cinepak is a lossy compression 
method.



clip
A reference to a segment of any media source or file that includes a start point, end point, and name. Only the 
reference is stored in DVP. Defining a clip sets the starting and ending points in a media file or media device.



clip media
Electronic images, music, and video that you can use in your own productions. Commercial clip media is available 
from many sources, such as clip libraries and electronic bulletin boards, and comes on different media, such as 
floppy disk and CD-ROM.



clipboard
A temporary storage location where Windows places the item most recently cut or copied.
DVP also contains its own internal clipboard, which it uses for copying and pasting clips. DVP does not copy clips to 
or paste them from the Windows Clipboard.
DVP does copy and paste palettes using the Windows Clipboard.



codec
Abbreviation for compressor/decompressor. During the video capture, the codec you select compresses the video 
file, so that it will require less hard disk space to store and less processing power to play back. Then, when you play 
the captured video, the codec decompresses the file.



compression
The process of compacting video data so that it will require less space on a hard disk. Video compression methods 
are lossy in nature--greater compression comes at the expense of quality.



cross-fade
The transition between two overlapping audio segments in which the first one fades out as the second fades in.



data rate
A way of referring to the amount of digital information that a video file contains. The data rate depends on several 
factors: the number of frames per second (fps) in the video; the frame size; the video and audio formats; and the type
of compression used. An uncompressed video with a high frame rate, relatively large frame size, and rich video and 
audio formats requires hardware capable of sustaining a high data rate to play back with acceptable quality. The 
appropriate data rate for a video depends on the capabilities of the delivery medium. In particular, CD-ROM drives 
support much lower data rates than disk drives do.



delete (segment)
When you delete a segment from the timeline, the succeeding portion of the clip moves over to occupy the position of
the segment you deleted. (In comparison, when you erase a segment, the succeeding portion of the clip does not 
move, and instead a gap appears in the clip.) You can control whether DVP deletes or erases segments by choosing 
Options from the Tools menu.



device driver
A program that allows Windows 3.1 to communicate with a specific piece of multimedia hardware, such as a video 
capture board. Device drivers are installed through the Windows Control Panel. See also multimedia.



device-independent
Describes an image or video that can be displayed at any resolution.



DIB (device-independent bitmap)
A Windows and OS/2 bitmap format. Indentical to .BMP.



digital audio
Audio that is converted into a digital format by a process called digitizing and stored as a file (usually a .WAV file) on 
a hard disk, CD-ROM, or floppy disk. See also analog audio.



digital video
Video that is converted into a digital format by a process called digitizing and stored as a file on a hard disk, CD-
ROM, or floppy disk. See also animation.



digitize
To convert analog audio and video into digital audio and video that can be manipulated on a computer.



display device
The combination of video card and video driver that determines a system's color capability. For example, an 8-bit 
video card used with the appropriate video driver can display 256 colors at a time.



dithered
Describes a color that appears onscreen as a mixture of different solid colors.



drag
In DVP, you move clips around by dragging them. You drag a clip by positioning the pointer over the clip or selected 
segment, pressing and holding down the left mouse button, and moving the mouse. As you do, the pointer arrow 
changes to a drag pointer. When the drag pointer is positioned where you want to place the clip or segment, you 
release the mouse button.



DVI
A hardware-dependent compression technique used with ActionMedia hardware.



DVP
Asymetrix Digital Video Producer.



DVP Capture
The utility that comes with Asymetrix Digital Video Producer that you use to digitize video from a source such as a 
VCR or videodisc. A capture board must be installed on your system for DVP Capture to work.



edit points
The in and out points representing the segment of a source clip to be used in a production.



8-bit color
Describes an image or video that can contain up to 256 colors.



erase (segment)
When you erase a segment, the succeeding portion of the clip does not move, and a gap appears in the clip. (By 
comparison, when you delete a segment from the timeline, the succeeding portion of the clip moves over to occupy 
the position of the segment you deleted.) You can control whether DVP deletes or erases segments by choosing 
Options from the Tools menu.



filter
A technique used to alter the appearance of an image on a single track, such as by changing its colors or applying a 
special effect. You apply a filter to a video by selecting a video on the timeline and choosing Filters from the Effects 
menu. Filters differ from transition effects because you apply filters to a single track, while transitions are applied any 
time two video tracks overlap.



FLI/FLC
An animation file format used by Autodesk Animator (and other programs) that is supported by DVP.



font
The complete set of characters for one typeface, size, and style, such as Courier 12-point italic.



fps (frames per second)
The number of complete images in one second of video, expressed as its frame rate. Digital video on the desktop can
support a maximum frame rate of 15 fps without the need for a video capture board; with a video capture board, 
frame rates of up to 30 fps are possible. (A video with a frame rate below 15 fps may appear jerky when played; 
television is broadcast at 30 fps; movies run at 24 fps.)



frame
A single image within a video file. Like a conventional video, a video file contains a sequence of frames that, when 
played back, gives the appearance of motion.



frame rate
The number of frames that occur in a video during a second of playback time, expressed in frames per second (fps). 
The higher the frame rate of a video, the better the quality.



frame size
The dimensions of a digital video image, usually expressed in pixels.



frequency
The number of samples per second in a sound or video file. The higher the frequency, the better the quality of the 
video or sound.



GIF
A compressed image format that can contain up to 256 colors. GIF format is widely used for images on commercial 
electronic bulletin board services (BBS).



high-color
A video or bitmap that is in 16-bit or 24-bit format. A high-color image or video does not require color palettes as an 8-
bit image or video does.



image
A still picture in the form of a bitmap.



in point
The point in a source clip where a segment begins. You specify an in point by using the editing controls in a Player.



Indeo
A lossy video compression standard designed by Intel.



JPEG (Joint Photographic Experts Group)
A lossy compression standard used for 24-bit color and 8-bit grayscale bitmaps.



key
To add a background color to an overlay, which is then made transparent so that the underlying video shows through.
Keying is used, for example, to create titles on an overlay; the key color becomes transparent, allowing the video to 
appear behind the titles.



key color
In the process of keying, the background color used for transparency in the foreground image. The key color 
becomes transparent when the video is built, allowing areas on underlying video tracks to show through, such as 
when you add a title overlay.



key frame
A complete video frame that contains all information about the image in the video. (By comparison, non-key frames 
typically contain only data about areas of the frame that have changed compared to the previous frame.)



keying
The process of displaying a background image through certain colors of a foreground image, such as the image of a 
meteorologist in the foreground superimposed on a weather map. The meteorologist is actually in front of a single-
color background panel, the color of which is then keyed to be transparent.



Kodak Photo CD
A compact disc that contains photos. To use Photo CD images, your CD-ROM drive must be capable of playing Photo
CDs.



lossless
Refers to a compression method that does not remove information from the video or image being compressed. The 
image quality is not affected by lossless compression methods, but file size reduction may not be as great as that 
achieved by lossy methods. Microsoft RLE is a lossless compression method. Compare lossy.



lossy
Refers to a compression method that permanently removes information from the video or image being compressed. 
Although the image quality is decreased, the results may be imperceptible to your audience, and the file size may be 
greatly reduced. Cinepak and Intel Indeo are examples of lossy compression methods. Compare lossless.



marking
The process of defining edit points on a source clip.



MCI (Media Control Interface)
A Windows standard set of commands that can be used to control media devices. Used for communication with 
external devices such as VCRs and videodisc players.



media device
Hardware that controls a source of multimedia. For example, a CD-ROM drive can play CD audio, and a sound board
can play MIDI and wave audio.



media device channel
A hardware device used to play a sound. Only one sound of a specified media type can play at a time through the 
channel, because only one sound at a time can access the necessary hardware. If you have a sound card with a 
MIDI port, you can play a MIDI and a wave audio file simultaneously, but you cannot play two MIDI files or two wave 
audio files simultaneously.



media file
Any wave audio, MIDI, animation, bitmap, or digital video file that can be used within Asymetrix Digital Video 
Producer.



media source
Any media--including files, CD audio, videodiscs, videotape, or embedded wave audio or MIDI resources--from which
you can create clips.



MIDI
Musical Instrument Digital Interface. MIDI devices are the standard way to connect synthesizers, keyboards, and 
other musical instruments to computers to create synthesized sound. MIDI is not actual sound, but a series of 
commands sent to the synthesizer. You must have a Media Control Interface (MCI)-compatible sound card installed to
play MIDI files.



MPEG (Motion Picture Experts Group)
A video compression standard that does not require, but benefits greatly from, built-in support provided by some 
video capture board manufacturers. MPEG is also used for compressing interactive television video. Refer to your 
video capture board documentation to determine if it supports this standard.



multimedia
Any combination of sound, graphics, digital video, animation, and analog video played on a computer.



nonlinear editing
Editing video using many video clips that can be manipulated and arranged independently and in combination, as in 
DVP.



NTSC (National Television Standards Committee)
Acronym for a video standard used in the U.S., Canada, Mexico, Japan, and Central and Latin America. The NTSC 
standard has a vertical resolution of 525 lines and 30 frames per second.



optimize
To create an 8-bit color palette based on the most frequently used colors in a range of video frames. You can optimize
a palette as you convert 24-bit or 16-bit video to 8-bit video to prevent palette shifts when the 8-bit video is 
subsequently played back.



optimization
A procedure that determines the most frequently used colors in a range of video frames and creates the best possible
256-color palette for a particular image or video clip, which you can then apply.



out point
The point in a source clip where a segment ends.



overlay
An image, digital video, analog video, or title that appears in front of the other images in your video. In DVP, overlay 
clips appear on the Overlay track. See also digital video, videodisc.



PAL (Phase Alternation by Line)
A video standard used in Western Europe (except France), Africa, the Middle East, and Brazil. The PAL standard has 
a vertical resolution of 625 lines and 25 frames per second.



palette
A predefined set of colors that is stored with a 256-color bitmap or video, or that you store in a palette file 
(extension .PAL). Palettes are for use with 256-color display devices; most often, you use them to create a common 
set of colors throughout a video and avoid palette shifts. You can create, save, load, and apply palettes to videos that 
you create in DVP.



palette shift
A brief flashing that occurs as you switch from one image to another (for example, by opening an image file or playing
a video clip) while using an 8-bit video display system. Windows switches color palettes so that the new image 
displays on your screen correctly. As it does, a brief flashing may occur, and the images and other portions of your 
screen may momentarily appear with the wrong colors. Although Windows quickly adjusts the screen to the new 
palette, the palette shift can be distracting to a viewer.



PCX
A Windows-compatible bitmap format used by many bitmap editing programs that may contain 1, 4, 8, or 24 bits. Also
called Paintbrush format.



pixel
Short for picture element. A dot of color in a video or still image. Combined, pixels of varying colors or shades create 
an image.



play
To activate a clip. You play a clip by dragging it into a Player window and clicking the Play button (unless Play Clip 
Automatically is checked in the Player Options dialog box).



project
A collection of source clips and effects arranged on the timeline and used by DVP to build new videos.



QuickTime
A video file format originally used on Apple Macintosh computers and now available under Windows. To use a 
QuickTime movie with DVP, you must first convert it to .AVI format.



RLE (Run-Length Encoding)
A type of 8-bit compression typically used with animation files and some bitmaps. It best provides compression for 
media that have relatively uniform color.



sample
The process of digitizing analog audio and video into computer information. Also called capturing.



scale
Frame sequence, expressed either as absolute frame numbers or in time code.



scanning
The process of creating a digital version of a graphic that you can manipulate on your computer.



SECAM
Acronym for a video standard (Sequentielle Couleur Avec Mémoire) used in France, Eastern Europe, Russia, and 
parts of Africa. The SECAM standard has a vertical resolution of 625 lines and 25 frames per second.



segment
In DVP, a series of sequential frames extracted from one media clip.



smoothing
When overlaying graphics or text, a method of blending the edges around the keyed areas. Also called anti-aliasing.



sound
A CD audio, MIDI, or wave audio clip that can be played in a DVP project.



TGA (Targa)
A bitmap format developed by Truevision. TGA is a standard format, but not as widely used as .BMP, .PCX, or .TIF 
formats. TGA files may be saved as uncompressed or compressed (run-length encoded).



thumbnail
A small image representing a video or other media clip, displayed as a placeholder on the DVP timeline, in the Media 
Window, or in a preview window (when a video is stopped).



TIF (or TIFF, Tagged Image File Format)
A platform-independent bitmap format standard created by Aldus. TIFF is used widely, but many variations of it exist, 
including different versions that may use any of six different compression methods (no-compression, Huffman, Pack 
Bits, LZW, Fax Group 3, and Fax Group 4).



time code
A method of representing time. HH:MM:SS:FF displays hours, minutes, seconds, and frames, respectively. Time code
(as opposed to frame number) is available with professional video decks; you use time code with DVP Capture to 
capture one or more specific sequences from a source video, based on their exact chronological positions in the 
source video.



title
Text that is added to a video, such as credits. In DVP, you can add titles to videos and control how they move, rotate, 
and zoom.



track
An area of the DVP window where you drag and drop a clip. You arrange clips (video, image, sound, transition, and 
overlay) on tracks to create your video.



transition effect
A special effect, such as a wipe, that creates a smooth shift from the end of one video clip to the beginning of another.



VCR
Video Casette Recorder.



video
A series of images that occur over time, and that may contain sound. In DVP, you create your video by combining 
other videos, bitmaps, and sound.



video capture
The process of digitizing audio and video into computer information. You can use DVP Capture to capture video files 
from a source such as a VCR, video camera, or videodisc, and then save the captured video as an .AVI file. Also 
called sampling.



video capture board
A specialized piece of hardware that allows your computer to digitize video from a source such as a VCR, a video 
camera, or a videodisc.



Video for Windows
A file format and specification for storing video and audio in Windows. The file format used is Audio/Video Interleaved 
(.AVI), a format that automatically synchronizes audio and video information.



videodisc
A read-only optical disc used to store analog video images and associated audio information, which you can use in a 
DVP video. See also multimedia.



VISCA
A protocol developed by Sony Corporation for controlling VCR machines from the computer, for precise and easy 
capture and editing.



visual media clip
A clip created from an animation, digital video, analog video, Photo CD image, or bitmap.



voiceover
Sound, such as narration, that you add to a video during the production process rather than while recording the video.



WAV (wave audio)
A digital audio format for sound that is stored as a file on a hard disk, CD-ROM, or floppy disk.



waveform
A representation of sound in which the volume of an individual sample is displayed, showing the peaks and lulls in 
volume over time.



zoom
To increase or decrease the size of a title or overlay. In DVP, you create zoom effects using the Path dialog box.



Learning Asymetrix Digital Video Producer
This section provides an overview of how to create a video using Asymetrix Digital Video Producer (DVP).

Although projects differ, creating a video follows a typical sequence described below.

To create a video:
1 Select media files and add them to the project.
2 Preview and mark a clip.
3 Place media on the timeline.
4 Add special effects.
5 Adjust color palettes.
6 Preview the video.
7 Build the video.
8 Save your project.



Selecting media files and adding them to the project
Learning DVP

After starting DVP, you begin a project by locating and importing media files. You can import video, audio, 
animation, or bitmap files in a number of file formats.
When you import video, you can

select existing files that are stored on a hard disk or CD-ROM.

use DVP Capture or another capture tool to capture video from a VCR, videodisc, or other source, then 
import the captured video into your project.

You import media files using the Import Media command on the File menu. When you import a media file, DVP 
adds the file to the Media Window. Although a file in the Media Window is associated with your project, it doesn't 
become part of your video until you drag it onto the timeline.
For step-by-step procedures, click the See Also button at the top of this topic.



Commands
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Step by step
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Previewing and marking a clip
Learning DVP

You can view or listen to a clip and mark the segment that you want to use in your video. You do this by dragging a
clip from the Media Window into either of the two Players. You can then preview the clip (whether it's a video, 
animation, bitmap, or audio clip), and mark the beginning and ending points of the segment you want to use in 
your video.
For step-by-step procedures, click the See Also button at the top of this topic.



Step by step
Adding a clip to the timeline
Marking a clip section
Playing a clip



Placing media on the timeline
Learning DVP

After you've used the Player to mark the clip segment that you want to use in your video, you're ready to place the 
marked segment on the timeline. You drag the segment from the Player to the timeline, after which you can move, 
copy, duplicate, and delete it. You can also add transitions and filters; titles and graphical overlays; and other 
video, audio, animation, and bitmap files.
For step-by-step procedures, click the See Also button at the top of this topic.
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Adding special effects
Learning DVP

After you place a media clip on the timeline, you can modify it. You can apply one or more filters to a single video 
track to create simple video effects, such as fade-ins and fade-outs, or more specialized effects, such as color 
inversion or ripples.
You can also determine how your video moves from one clip to the next by modifying the transition between them. 
For example, you can choose whether or not to cross-fade audio as one clip ends and the next begins. Or you can
choose from a list of video transition effects (many of which you can customize) to control how one video clip ends 
and the next begins.
Finally, you can easily add titles and other overlays, and specify key colors. You can also control how titles and 
other overlays move, zoom, or rotate in the video.
For step-by-step procedures, click the See Also button at the top of this topic.
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Adjusting color palettes
Learning DVP

Getting acceptable color quality can be a challenge when you're working with 8-bit video files, which are commonly
used in desktop presentations. If an 8-bit video file uses several different color palettes, the video displays palette 
shifts as it plays.
DVP can help you avoid these palette shifts and create smooth, professional videos. You can create a single 
palette that is optimized for the colors in your video; you can also edit the optimized palette to include the 
background colors of the presentation or multimedia title in which your video will play. Finally, you can save an 
optimized palette to use in other videos.
Note Although you typically create and apply palettes after importing and arranging media clips on the timeline, it's
a good idea to plan for color before you start creating a video. In general, if your final video will be played back on 
an 8-bit monitor, you should try to limit color changes within the original video. Alternatively, you can avoid color 
palette problems by using black-and-white videos or simpler animations.
For step-by-step procedures, click the See Also button at the top of this topic.
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Previewing the video
Learning DVP

As you create your video, you can check your progress frequently without actually building a version of your video 
(which can be time-consuming). Instead, you can preview the contents of the timeline, including transitions, filters, 
titles, keying, audio, and palettes that you've applied.
Note Previewing the contents of the timeline is different from viewing a single media clip in a Player. You preview 
the contents of the timeline in the Preview window, where DVP plays each media clip and effect simultaneously; as
a result, playback is slower than it is in the final video. In contrast, you view (and mark) single media clips in a 
Player, where you can step through them frame by frame or play them in real time.
For step-by-step procedures, click the See Also button at the top of this topic.
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Building the video
Learning DVP

When your project is arranged the way you want it on the DVP timeline, the challenge is to build an .AVI file that 
meets both your technical and aesthetic requirements. (You can also build a final file in other formats, such as a 
series of bitmaps or an audio file.)

At this stage, you must decide how to balance quality and economy. In general, the larger the frame size, frame 
rate, and bit depth you choose for the .AVI file, the higher the quality of the video. On the other hand, the higher 
the quality of the video, the more hard disk space you need to store it, and the more RAM and computer 
processing speed you need to play it properly. If your audience's equipment cannot handle high-quality video 
playback, then you may get better results by producing video files of moderate quality. 

The following questions can help identify the decisions you must make before you build a file:

How many colors do you want to display: Will your video be 8-bit, or better?

What size and visual quality do you require?

How clear and crisp must the audio sound? Does the audio only include a voiceover, or does it include 
music that requires higher-quality reproduction?

How much information will the playback equipment be able to handle? In particular, will the video be played 
back from a CD-ROM (which is slower than a hard disk, and therefore can't handle as much information)?

What are the file size limitations for your video?
Note In addition to frame size, frame rate, and bit depth, other build settings you choose affect the final quality and
size of your video files. These settings include the quality of the audio, the type of compression, the data rate, the 
number of key frames, and others.
For step-by-step procedures, click the See Also button at the top of this topic.
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Saving your project
Learning DVP

You should save often throughout the process of creating your project file, as you do for any important computer 
work. When you save your project file, you save the links between it and any media files you've imported since the
last time you saved. Then, if you move those media files between sessions of working on a project file, DVP will 
prompt you to locate the files. Saving also preserves all of the editing work you do on the timeline.

Saving often helps you avoid losing work in the event that a system failure or other problem occurs, and preserves
the current project for you to use as the basis for creating different versions of your video in the future.
For step-by-step procedures, click the See Also button at the top of this topic.
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Saving a project





Video and sound concepts
Click a topic below for more information.

About color palettes
About filters
About frame rate
About frame size
About media file formats
About sound
About transitions
Compression tips
Sound tips



About color palettes
Concepts

If you create a video in DVP to play back on an 8-bit (256-color) display device, such as a standard SVGA video 
system, you'll get the best color results if you learn how to work with palettes. In DVP, you use color palettes for 
two reasons:

To reduce the thousands or millions of colors in your project's images and video clips to the 256 colors 
available for playing back the output video at the best quality possible.

To prevent palette shifts when you use your video in a presentation that has its own palette.
You need to create and manage palettes only for 8-bit graphics, including bitmaps, animations, and videos created
with RLE compression or Microsoft Video 1 compression. A high-color video does not require color palettes, 
because it can display all possible colors at once.
In a video, each segment might require a different palette in order to display correctly; the resulting palette shifts 
during playback are distracting. To avoid palette shift, you can create an optimized palette that combines the 
dominant colors of all segments of the video.
8-bit images contain a palette of the 236 most common colors in that image (256 colors minus 20 colors reserved 
by Windows), which Windows uses to determine which 236 colors to use when displaying the image. If the palette 
is optimized correctly, the image displays at the best quality possible within the limits of the display device.
Note If you're creating video sequences for 8-bit systems, use an 8-bit video format. If you play high-color video 
sequences on an 8-bit display device, Windows dithers colors, which reduces the speed and quality of the display.
DVP uses its own palette when displaying images in the Media Window, on the timeline, or in a video paused in a 
Player. When you play a video clip in a Player, DVP switches to that video's palette. When playback is complete or
paused, DVP switches back to its own palette. The DVP palette is stored in the DVP.PAL file. If you delete this file, 
DVP uses a grayscale palette in its place.
If you want to avoid switching palettes, check Play Video Using DVP Palette in the Player Options dialog box, 
which maps video playback to the DVP palette.
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About filters
Concepts

DVP provides several filters, which you can apply to a video track one at a time or in combination.

Filter Description Options
Fade To Black Fades selected video to 

black, or fades video from 
black to image.

Out To Black 
In From Black

Fade To White Fades selected video to 
white, or fades video from 
white to image.

Out To White 
In From White

Black And White Changes selected video from 
color to black and white.

None

Color Inversion Changes selected video's 
RGB values to their opposite 
values.

Red Channel 
Green Channel 
Blue Channel

Ripples Warps selected video so it 
ripples like water.

Number Of Waves
Wavelength

Color Balance Adjusts selected video's RGB
values.

Red
Green
Blue

Brightness And 
Contrast

Adjusts selected video's 
brightness and contrast.

Brightness, Contrast

Tile Replicates selected video in a
tile pattern.

Vertically n Times
Horizontally n Times

Blur Blurs selected video. Adjust Blur
Sharpen Improves clarity of selected 

video.
Adjust Sharpening

Emboss Dims color in selected video 
and traces object's edges in 
black, for a sculpted look.

None

Chalk Drawing Dims color in selected video 
and traces object's edges 
with a feathered line, for an 
outlined look.

None

Snow Adds noise to selected video 
to simulate television 
interference.

Adjust color and intensity of 
snow.

Flip Flips selected video 
horizontally and/or vertically.

Vertical, Horizontal, or 
Horizontal And Vertical

Fade To Snow Fades selected video to 
noise.

Fade Direction And Style
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About frame rate
Concepts

Frame rate indicates the number of frames that occur in a video during one second of playback time, expressed in 
frames per second (fps). The higher the frame rate of a video, the better the quality.

An AVI file typically plays at 15 or 30 fps. The higher frame rate of 30 fps (approximately the frame rate of NTSC-
broadcast television) provides smoother motion, but also results in a much larger video file and requires a video 
board to run smoothly. A frame rate lower than 15 fps results in a smaller video file but can appear rough or jerky 
when played back.
When DVP builds the new video file, it uses the frame rate specified in the Frames/Sec box in the Output Format 
dialog box, typically 15 fps. If you use a clip with a different frame rate--such as a clip at 20 fps--DVP must adjust 
the clips to compensate for the change in frame rate.
For example, if the frame rate you want is 20 fps, but you add 5 seconds from a 10 fps video clip, you actually add 
50 video frames to the new video. However, at the new frame rate of 20 fps, the 50 frames result in only 2.5 
seconds of video.
Mixing frame rates can cause problems with the audio portion of the final video file because audio is measured in 
time, not frames. In the previous example, you added 2.5 seconds of video. However, you are inserting a full 5 
seconds of audio into the new video, so audio and video from the source clip will no longer be synchronized.
To maintain video/audio synchronization while mixing frame rates, select Synchronize Video in the Output Format 
dialog box. This option causes video frames to be dropped or added as needed to maintain the full 5 seconds of 
video at the new frame rate. This option can also be used to create slow-motion and fast-motion effects.
If it is more important to maintain the exact number of frames, even if they result in a longer or shorter video, 
select Maintain Frame Numbers.
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About frame size
Concepts

A video's frame size refers to the dimensions of the area onscreen where a video is displayed. Frame size is 
expressed in X (horizontal dimension) and Y (vertical dimension) values in pixels.
In DVP, you select the frame size in the Output Format dialog box. Selecting a frame size depends on the amount 
of space available for storage and the capabilities of the system used to play it back. Many .AVI files are created at
a frame size of 160 by 120 pixels. Although larger frame sizes may look better, they also require more disk space 
and a faster machine on which to play back. For example, a 320-by-240-pixel video requires four times the disk 
space, and may play back with jerky motion, compared to the same video displayed at 160 by 120 pixels. 
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About media file formats
Concepts

You can store images, audio, and video in a number of formats. Each of these types also has a number of 
attributes, such as compression, data rate, and frame size. 
DVP can import and build the following file formats:

For video files: audio/video interleaved (.AVI) format

For audio-only files: wave audio (.WAV) format

For animation files: .FLI and .FLC formats

For still images: .BMP, .DIB, .GIF, .PCX, .TIF, and .TGA formats
Tip To view the format information about a media clip, double-click the thumbnail image in the Media Window. Or 
select the clip, then choose Media Statistics from the File menu.
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About sound
Concepts

An integral part of every video is the soundtrack or audio. To use audio in DVP effectively, you need to understand 
these concepts:

Channels The number of output devices (such as speakers) to which sound can be directed. Mono plays 
the same audio through both channels, while stereo has two separate channels. Typically on the computer, stereo is 
only used for high-fidelity music applications.

Sample size The amount of data in each sample of audio. Most desktop applications use 8-bit sampling; 16-
bit sampling is equivalent to CD-quality sound.

Sample rate The number of audio samples per second, expressed in kilohertz (kHz). The higher the sample
rate, the better the sound quality (and the more space required). DVP works with audio files sampled at 11.025kHz, 
22.05kHz, and 44.1kHz.

Higher-quality audio is not always your best choice. For example, an audio track that is 44.1kHz, 16-bit stereo 
requires 16 times the space of the same audio sampled at 11.025kHz, 8-bit mono. Because the amount of data in 
an audio stream can drastically reduce the playback performance of the video, you should always use the lowest 
acceptable quality for audio. Use the following general rules to begin with, but always test to be sure you achieve 
the quality you want:

For sound effects, choose 11.025kHz 8-bit mono.

For voiceovers, choose 22.05kHz 8-bit mono.

For music, choose 44.1kHz 8-bit stereo.
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Sound tips
Concepts

Selecting what your audience will hear, and how they hear it, is critical to the quality of your video. When adding 
sound to your video, keep the following tips in mind:

Recording sound If you record your own sound, always make sure your audio track is loud enough by 
positioning your microphone as close as possible to the sound source. You might find that an external microphone 
with a long cord helps you get professional-quality sound. When recording a soundtrack to edit, keep in mind that the 
quality of audio recording on a hi-fi camcorder is probably better than any nonprofessional recording equipment you 
may own.

Adding narration If your video is not self-explanatory, a voiceover can be an important tool for clarification. 
When using narration, remember to fade down music or any other sound during narration segments. With DVP, you 
can easily add narration by dropping it on the unused audio track. If necessary, you can fade the other audio track to 
accommodate the narration.

Adding music Select music based on the mood, tempo, and energy you want to convey. You can add 
music from any audio source (provided that you have secured copyright permission as necessary), including libraries 
of stock music on CD-ROM.

Remember to fade music in and out to avoid any abrupt blast of sound. If you need to add both narration 
and music to an original soundtrack, add the narration first, then build the video. Afterward, load the new video, place 
it on the Video A and Audio A tracks, and then add music to the Audio B track.

Matching video and audio Videos look most professional when a video cuts from one scene to another 
with the rhythm of the sound. Make your cut when the tempo of the music changes, or when the narrator pauses. In 
DVP, you can use the waveform graphs on the audio tracks to locate these changes and pauses.

Using sound with transitions Audio from one scene can lead into the next, producing a smoother 
transition. Creating this type of smooth transition is called transparent editing. For example, from one scene you can 
continue the audio track of a conversation for a couple of seconds into the next scene, so the audience sees the 
beginning of the second scene while hearing the end of the conversation.



Commands
Audio Cross-Fade
Audio Level
Concepts
About sound
About transitions



About transitions
Concepts

When two video tracks overlap, DVP automatically adds the default transition, a Dissolve. You can change the 
default transition by applying one of the transitions below.

Transition Description Options
Dissolve First video fades into second video. None
Wipe Second video gradually covers first 

video.
Wipe Direction

Iris Second video opens up inside first 
video, gradually covering it.

Iris Shape

Clock Second video sweeps over first video in
clockwise direction.

None

Slide In Second video slides onscreen over first 
video.

Slide In Direction

Slide Out First video slides offscreen, revealing 
second video.

Slide Out Direction

Band Slide In Bands of second video slide onscreen, 
covering first video.

Vertical or Horizontal 
Number Of Bands

Band Slide Out Bands of first video slide offscreen, 
revealing second video.

Vertical or Horizontal 
Number Of Bands

Barn Doors First video splits and slides open to 
reveal second video.

Vertical or Horizontal
Open or Closed

Blinds Bands of second video gradually cover 
first video.

Vertical or Horizontal 
Number Of Blinds

Push Second video pushes first video 
offscreen.

Push Direction 

Blocks Blocks of second video appear, 
covering first video.

Grid
Remove Blocks

Fizzle First video dissolves pixel by pixel to 
reveal second video.

None

Blizzard First video blows offscreen pixel by 
pixel to reveal second video.

None

Soft Wipe Second video gradually covers first 
video using a softer edge than a Wipe.

None
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Compression tips
Concepts

Video compression modifies a video file to decrease its size.
Video sequences are compressed and decompressed by special routines called codecs. You use the compressor 
portion of a codec when you create a video; when you play back the video, the codec decompresses the video so 
it can be displayed on your computer system.
You can choose from among several types of compression when you create a video in DVP. The one you choose 
depends on the quality you need (meaning both how the video should appear and how smoothly it should play); 
file size limitations; and the time required for compression and playback. You may have to experiment to determine
which compression method works best for your video.
Note Avoid applying multiple compression methods to a video sequence. Most methods result in some loss of 
quality, and the loss is compounded if multiple techniques are applied. When experimenting with compression 
settings, save the original uncompressed version of your video sequence.
If you have a video capture board, you may have other compressor drivers than the codecs provided with DVP. 
For details, refer to your video capture board documentation.
DVP includes these codecs:

Microsoft Video 1

Cinepak Codec by SuperMatch

Intel Indeo Video R3.2

Intel Indeo Video Raw

Microsoft RLE

Full Frames (uncompressed)
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Microsoft Video 1
Combines good playback quality with relatively quick compression time. If you use the 8-bit format, you can specify 
which palette to use in the video sequence, providing better control over the palette colors than compression methods
using an automatic dithering technique. This method does not support 24-bit color.



Cinepak Codec by SuperMatch 
Provides excellent compression for video sequences delivered on CD-ROM. Cinepak provides good image and 
motion quality at CD-ROM data-transfer rates. The video sequence is stored using the 24-bit color format, which 
preserves much of the original video's color information. When playing on 8-bit displays, Cinepak uses dithering to 
transfer the 24-bit color values to an 8-bit palette format. Cinepak uses an asymmetrical compression technique, one 
that takes much longer during compression than during playback.



Intel Indeo Video R3.2 
Provides high-quality video for delivery on CD-ROM and other systems. Indeo uses an asymmetrical compression 
technique and stores the video in a 24-bit color format. When played on 8-bit video display devices, the codec dithers
the 24-bit color to an 8-bit format. Intel recommends using a key-frame interval of 4.



Intel Indeo Video Raw 
Creates smaller video files by separating the color information differently rather than by compressing the file. 
Available on any video capture board that uses the I750 compressor chip, such as the Intel Smart Video Recorder or 
Creative Labs Video Blaster RT300. Offers you a viable way to reduce file sizes during video capture and then apply 
more significant compression later in your video production process.



Microsoft RLE 
Provides compression best used for computer-generated animation, bitmaps, and media that have relatively uniform 
color. The quality suffers and file size increases with more complex video scenes, such as live video that you're 
capturing directly from a video camera. You can use this method only when producing 8-bit video sequences.



Full Frames (uncompressed) 
Saves each frame in the video as an uncompressed bitmap. If the sequence was already compressed, the bitmaps 
will show any distortions introduced during compression. While it can save some time to do rough-cut editing in this 
format, and only compress after the final cut, DVP's drivers minimize recompression.



Importing media
Step by step

Importing media into a project is the first step in editing a video. DVP imports only information about the location of
the media file on your hard disk or CD-ROM; the file itself is not moved, copied, or altered.

To import a media clip:
1 Click the Import Media button on the toolbar. Or choose Import Media from the File menu.
2 Select one or more media files to import. (Press Ctrl as you click to select more than one file.)
3 Select a file type from List Files Of Type.

If you want to preview an .AVI or .WAV file before importing it, click Preview after selecting the file, then click the
Play button that appears. To preview additional media files, continue to select files and click the Play button.

4 Click OK.
The file or files you selected appear in the Media Window.

Note To import a media file, the file extension must correspond to the driver installed on your system. File 
extensions for each installed driver are shown in the Import Media dialog box.



Saving a project
Step by step

When you save a project, you save information about the arrangement of media clips, transitions, filters, and titles 
on the timeline, as well as information about the location of the associated media files on your hard disk or CD-
ROM. 
Saving a project does not create or save your video; to do that, you must build your video.

To save a project:

Choose Save Project from the File menu.
If the project has never been saved, the Save Project dialog box opens, in which you name the project. By 
default, DVP adds the .PRJ file extension.

You can also save a new version of an existing project. For example, you may want to create multiple versions of a
single video.

To save a new version of an existing project:

Choose Save Project As from the File menu.
The Save Project dialog box opens, in which you type a new name for the project. By default, DVP adds 

the .PRJ file extension.
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Starting a new project
Step by step

Starting DVP automatically opens a new project, into which you can import media files for viewing and editing. You
can also start a new project after working on an existing one. However, only one project can be open at a time.

To start a new project:

Choose New Project from the File menu.
DVP opens a new project file and clears the timeline of all existing clips and effects. If you have not saved 
changes you made to an existing project, DVP prompts you to save them before clearing the timeline. Media 
from the previous project remain in the Media Window of the new project. You can then import additional files, 
or remove files.
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Adding a clip to the timeline
Step by step

You add a clip to the timeline by dragging it either from a Player or from the Media Window.

To add a clip to the timeline:

Drag the clip from a Player or from the Media Window to the position on the tick bar where you want it to 
begin.

DVP adds the media file to the timeline on the appropriate track (video, audio, or overlay) at the position of 
the cursor. For video files that contain sound, DVP adds the video portion of the file to a video track, and the sound 
portion to an audio track.

Note If Snap Cuts To End is checked in the Options dialog box, DVP adds the video to the end, not at the 
cursor.

If you drag a clip from a Player in which you've marked edit points, DVP adds only the marked segment to 
the timeline. Otherwise, DVP adds the entire clip to the timeline.

You can also drag a clip directly from the Media Window to the track on which you want it to appear. 
However, if you add a video clip containing audio to an audio track, only the audio portion is added.
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Moving a clip on the timeline
Step by step

You can move a clip on the timeline by dragging it from one position to another, or by cutting and pasting it. When 
you cut a clip, DVP places a copy on the DVP clipboard, so you can subsequently paste it as many times as you 
want. You can also move a section of a clip.

To move a clip by dragging:

Click the clip to select it, then drag it to a new location. DVP moves the clip to start at your new insertion 
point.

To move a clip by cutting and pasting:
1 Click the clip to select it.
2 Click the Cut button on the toolbar. Or choose Cut from the Edit menu (Ctrl+X).
3 Click where you want to position the clip on the timeline.

You can move a clip to either video track, either audio track, or to the Overlay track. However, if you add a 
video clip to an audio track, only the audio track actually gets added (if the video clip has an audio track).

4 Click the Paste button on the toolbar, or choose Paste from the Edit menu (Ctrl+V).
To move a section of a clip:
1 Make sure the entire clip is not selected.
2 Press Ctrl and drag along the clip to select only the section you want to move.
3 Continue pressing Ctrl as you drag the section to a new position on the current or a different track.

When you move a section of a clip, the section is either deleted or erased from the original clip, depending on 
the Cut/Paste option setting in the Options dialog box.
Note You can select a section of all tracks simultaneously by pressing Ctrl and dragging along the tick bar. 
Continue to press Ctrl as you move the selection to its new location.
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Copying a clip
Step by step

You can copy a clip from the timeline and then paste the copy back onto the timeline.

To copy a clip:
1 Click the clip to select it. Or press Ctrl and drag along the clip to select the section you want to copy.

Note If you want to select a section of a clip, make sure the clip is not selected before you press Ctrl and drag.
2 Click the Copy button on the toolbar. Or choose Copy from the Edit menu.

DVP copies the clip to the DVP clipboard. You can then paste or duplicate (paste multiple copies of) the clip.
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Playing a clip
Step by step

You can play an individual clip (except an .FLC or .FLI clip) in your project at any time.

To play a clip:
1 Click    a clip in the Media Window or on the timeline to select it.
2 Drag the clip to a Player window.

If Play Clip Automatically is checked in the Player Options dialog box the Player immediately plays the clip. 
Otherwise, click the Play button. 
If you drag the clip from the Media Window, the entire clip plays. 
If you drag a clip from the timeline that was part of a longer clip, only the portion from the timeline plays.
You can pause, play, step forward, and step backward through the clip using the Player control buttons.

Tip You can play the last video you built (since you started DVP) without importing it into the current project by 
choosing Play Last Built from the Video menu.
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Marking a clip section
Step by step

You mark a section to define the range that you want to use in your project. You can either set a clip's beginning 
and end frames as you play the clip in the Player window or you can enter the frame numbers. Entering the frame 
numbers can be particularly useful when you are working with long video clips.
Marking a clip section sets edit points for the clip. If you drag the clip from the Player window onto the timeline, 
only the marked section appears on the timeline and is included in the output video. 

To mark a clip section while the file plays:
1 Drag the clip from the timeline to a Player window.

If Play Clip Automatically is checked in the Player Options dialog box the Player immediately plays the clip. 
Otherwise, click the Play button. 
Note DVP can play all types of media files except .FLC and .FLI files.

2 When the clip reaches the frame you want to use as the first frame, click the Mark In button.
3 Play the clip until it reaches the frame you want to use as the last frame, then click the Mark Out button.

For fine adjustment, use the Player control buttons to step forward or step backward, then click the Mark In or 
Mark Out button. 
If you drag the clip section to the timeline, only the marked section appears on the timeline.

To mark a clip section by entering the frame numbers:
1 Press the Ctrl key as you click either the Mark In or Mark Out button. 
2 In the In/Out Adjust dialog box, enter the particular frame number, then click OK. 

If you drag the clip section to the timeline, only the marked section appears on the timeline.

Note You can edit the beginning and end frames by repeating this procedure and clicking new Mark In and Mark 
Out locations.
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Modifying a transition
Step by step

When you add a clip to one video track on the timeline, and it overlaps a clip on the other video track, DVP 
automatically assigns a default transition (a Dissolve) to the Transition track. This causes one clip in your output 
video to flow smoothly into the next. You can easily modify the transition by choosing another type of effect. 

To modify a transition:
1 Double-click the transition on the Trans track to open the Transitions dialog box.
2 Click the thumbnail representing the transition you want to modify.

A description of the selected transition appears at the top of the dialog box, and the selected thumbnail 
demonstrates the transition. Scroll the Transitions box to view other transitions.

3 Click Options to specify options for the transition.
The thumbnails demonstrate only the basic transition, and not the options that you specify.

4 Optional. Preview the transition by clicking the Play button.
5 Click OK to close the Transitions dialog box and apply the transition.
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Removing a transition effect
Step by step

You can remove a fancy transition effect. However, because a transition is necessary any time a clip on one video 
track overlaps a clip on the other video track, removing a transition effect restores the default Dissolve transition 
effect.

To remove a transition effect:

Click the transition on the Trans track to select it, then press Delete.
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Previewing a video
Step by step

You can preview your video as you work to check your progress. When you preview a video, DVP plays all visual 
tracks (all video, transitions, and other visual effects) in the timeline simultaneously. Because of the complexity of 
mixing all tracks, previewing a video generally runs more slowly than the final video.

To preview a video:
1 Click the tick bar where you want the preview to begin.
2 From the Video menu, choose Preview to open the Preview window.
3 Click the Play button in the Preview window.

The video plays one frame at a time.
You can play or pause the preview using the button in the lower left corner of the Preview window. If you modify
the clip in the timeline, the Preview window immediately reflects your changes. To close the Preview window, 
double-click the Control-menu box.
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Building a video
Step by step

Building is the final step in creating a video. 
The time DVP requires to build a video ranges from a few minutes to several hours, depending on the type of 
system you have, the size and length of the clips, the format of your video, the type of compression used, and the 
effects you applied.
Before you start the build, make sure 

all clips are edited and arranged on the timeline as you want them.

transitions, filters, titling, and other effects are as you want them.

you've specified the format for the final video.

you've specified compression options for the final video.

you've determined the best way to handle the color palettes if you're building 8-bit output video.

you have enough hard disk space for the video.

you've previewed the video.
Note Because fragmentation of your hard disk can affect the quality of the video, you should run a utility to 
defragment your hard disk, if necessary, before building your video.

To build a video:
1 Choose Build from the Video menu.
2 Select options for your video, then click Build.

The Build Progress window opens, in which you can view the output video as DVP builds it.
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Adding and editing titles
Step by step

In DVP, you can quickly add titles to your video, then edit them as you want, for example, specifying fonts and 
colors. You can also animate your titles, for example, moving, magnifying, or rotating them. When you build your 
video, DVP displays the text on top of the video.
You add titles to the Overlay track. A project can contain only one overlay.

To add a title:
1 Do one of the following:

Select the section of the clip that the title will overlay, then choose Titling from the Effects menu.

Ensure no clips are selected, then choose Titling from the Effects menu. In the Title Frames dialog box 
specify the frames in which the titles should appear, then click OK.

2 In the Titling dialog box, type your titles in the Edit Title box.
Type each title on a separate line.

3 Select each title and apply font settings or a foreground color by clicking the buttons at the top of the dialog 
box.

4 In the Title Frames box, enter the title's starting and ending frames.
5 Click Path to adjust the path (the position, movement, zoom, and rotation) of each line of text, then click OK.
6 Click OK.
7 Optional. To preview the title, choose Preview from the Video menu.

To edit a title:

Double-click the title on the Overlay track to open the Titling dialog box.

To delete a title, select it and press Delete.
The titles appear on the Overlay track. Unlike clips, you cannot move or copy titles on the timeline. 
Tip You can apply a different set of attributes to each line of text in a title. For example, to display text with two 
different sets of attributes simultaneously, you apply the attributes to each line of text, and assign them the same 
frame ranges, then adjust their positions by selecting each title and clicking Path.
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Capturing video using an MCI-controllable device
Step by step

With an MCI-controllable videocassette recorder (VCR), you can use DVP Capture to specify exact starting and 
ending points for capturing from a videotape. You can capture up to ten video segments as a single unattended 
batch job. In addition, using an MCI-controllable device can improve the quality of the capture, because you can 
set DVP to step through the capture one frame at a time.
Note You can only capture video from an MCI-controllable device if that device is correctly installed in Windows.
Using the Step Capture option, you can have DVP step through the video one frame at a time, capturing and 
storing each frame sequentially. Depending on your capture hardware, this option may provide better image 
quality and compression because DVP will not need to drop frames. Use this option when you specify a large 
frame size, high-quality compression, high frame rate, or other demanding captures.
When you use Step Capture, select Capture To Disk in the Capture Settings dialog box so that you capture the 
video to disk. This option ensures that your MCI driver has the memory it needs to perform the task. 
Note The Step Capture option can require significantly more time than normal capture. Use Step Capture only if 
necessary. If you can achieve acceptable quality using normal motion capture, do so.
If you are concerned about having enough disk space for capture, you can use DVP Capture's Allocate File Space
command on the File menu to pre-allocate disk space for the capture file. The first file listed in the list is the pre-
allocated capture file. Keep in mind that only the first video you capture can use this file.

To capture video using an MCI-controllable device:
1 In DVP Capture, choose Settings from the Capture menu.
2 Check Enable MCI Capture, then click MCI Settings.
3 From the MCI Driver list, which contains the currently installed MCI-controllable devices, select the device you 

plan to use.
4 Optional. Check Step Capture to have DVP capture and store each frame sequentially.
5 To add a capture file, click New to open the Add New Video dialog box.
6 Select or enter the name for the capture file, set the Start and End times for the capture, and then click OK.

Specify the Start and End times in time code (HH:MM:SS:FF); for example, 00:08:18:03. To use the current 
frame as either the start time or end time, click the cursor in the Start Time or End Time box, then click Use 
Current Frame.

7 Continue to modify the capture list as you want.

To add additional video captures to the list, repeat Steps 5 and 6.

To modify a capture specification you've already added, select the capture file in the list, then click Edit.

To delete a capture specification, select the capture in the list and click Delete.
8 When the capture list is complete, click OK.



Editing a palette
Step by step

By using PalEdit with DVP, you can edit a color palette to

modify any color in a palette.

modify the entire palette for brightness, contrast, or color tint.

reduce the number of colors in a palette by deleting or merging colors.

copy colors from one palette to another; for example, to include background colors.

build a custom palette that you can export from the DVP project.
To edit a color in a DVP palette:
1 Create or import a palette.
2 Choose Edit Palette from the Palette menu.

The palette you created or imported opens automatically in PalEdit.
3 Click a color cell to select it.
4 Choose Edit Color from the Palette menu in PalEdit, or double-click the color cell.
5 Drag the cursor to a new area on the color grid to change the color, then move the slider up or down the vertical

bar to adjust the luminance.
You can also enter different values in the Red/Green/Blue or Hue/Saturation/Luminance box to edit the color.

6 When you finish editing the color, click OK.
7 Exit PalEdit to return to DVP. Click Yes or No to save the changes in your project palette.

To delete selected colors:
1 In PalEdit, press Shift and click each color cell you want to eliminate.
2 Choose Delete from the Edit menu, or press Delete (or Del) on your keyboard.

To merge selected colors:
1 In PalEdit, press Shift and click each color cell you want to merge.
2 Choose Merge Selected Colors from the Edit menu.

For complete details on how to edit colors in PalEdit, refer to the PalEdit online Help system. To run PalEdit as an 
independent program, locate and double-click the PalEdit program icon in the Asymetrix Digital Video Producer 
program group.
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Copying a palette
Step by step

You can copy a palette from one frame of a clip and apply it to the entire project.

To copy a palette from a frame:
1 Press Ctrl and click to select a frame on the timeline that contains the palette you want.
2 Choose Copy Palette From Selection from the Palette menu.

DVP copies the palette to the Windows Clipboard.
3 Choose Paste Palette from the Palette menu.

DVP pastes the palette into the project, where it is applied to all frames when you build an 8-bit output video.
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Creating an optimal palette
Step by step

When you build an 8-bit video, DVP can automatically create an optimized palette and apply it to the output video.

To create an optimal palette:
1 Choose Create Palette from the Palette menu.
2 Specify the frames that DVP uses to generate the optimal palette:

Click Whole Video to create a palette based on all the clips on the timeline.

Click Section to create a palette based on the range of frames you specify.
3 Click OK.

A preview window opens as DVP creates the palette. You can stop building a palette by clicking Stop Build.
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Importing a palette
Step by step

If you have exported or created a palette as a separate palette file, you can import it and apply it to your video.

To import a palette:
1 Choose Import Palette from the Palette menu.
2 Locate and select the palette file you want to open, then click OK.

You can identify palette files by the .PAL extension. 
DVP imports the palette into the project and applies it to all frames when you build an 8-bit output video.
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Exporting a palette
Step by step

DVP lets you export a palette as a file that you can apply to other videos.

To export a palette:
1 Create an optimal palette or copy a palette from a frame.
2 Choose Export Palette from the Palette menu.
3 Enter a name and location for your palette, then click OK.

DVP saves the palette with the name you specify and a .PAL extension.
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Capturing video
Step by step

You can use DVP Capture to capture video from a VCR or videodisc player and save it as an .AVI file that you 
import into DVP. The procedure below describes the basic steps for capturing a video; however, you may need to 
experiment with these steps to obtain the best quality possible on your system.
Note Capturing video is demanding on your system. You can prepare for the best possible capture by 
defragmenting your hard disk using any of the commercially available defragmentation programs. In addition, 
capturing video works best if you capture to an uncompressed drive (that is, a drive on which you're not using 
Stacker or DoubleSpace). You must have a video capture board installed on your system for DVP Capture to start.

To capture video:
1 In DVP, choose Capture Video from the Tools menu to start DVP Capture.

If you start DVP Capture from within DVP, the captured video is automatically added to the Media Window. 
You can also start DVP Capture by double-clicking the DVP Capture icon in the Program Manager, however, 
you must then import the captured video into a DVP project.

2 In DVP Capture, to set the file name for the captured file, choose Set Capture File from the File menu.
3 To allocate space for the captured file, choose Allocate File Space from the File menu.
4 Set capture options:

Choose Audio Format from the Options menu to set options for capturing audio.

Choose Video Format from the Options menu to set frame size and other settings supported by your capture
board.

Choose Settings from the Capture menu to set general capture settings.

Choose Compression from the Options menu to set compression methods for saving the captured video, as 
well as other options that affect the quality (and file size) of the video.

Choose Video Source from the Options menu to specify settings for the video signal from your capture 
board, if your video capture board supports these features.

Choose Video Display from the Options menu to specify settings for your capture board's video signal, if 
your video capture board supports its own VGA monitor output.

5 If your video capture board supports 8-bit video formats (many do not), you can apply an 8-bit palette to the 
captured file.
For more information, see Palette (DVP Capture).

6 Set preview options.
You can choose from Preview Mode or Overlay Mode, if your video capture board supports video overlay.

7 Start playback on your VCR or other video device.
8 To capture the video, do one of the following:

Choose Single Frame from the Capture menu to capture the current frame.

Choose Frames from the Capture menu to capture video as a series of individual bitmaps.

Choose Video from the Capture menu to capture motion video.

Choose Palette from the Capture menu to capture the palette of the current frame, which you can then save 
or apply to the entire capture file.

9 If necessary, end the capture by pressing Esc.
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Playing your built video
Step by step

After building a video file, you can play it back using DVP, Media Player, or another video tool, such as VidEdit, 
that supports .AVI files. When you install DVP, the Setup program also installs Media Player and the .AVI drivers 
you need on your hard disk. 

To play a video file in DVP:
1 Start DVP.
2 Choose Open Project from the File menu.
3 Select the DVP file you want to play, then click OK.
4 Drag the file from the Media Window to a Player.

If Play Clip Automatically is checked in the Player Options dialog box the Player immediately plays the clip. 
Otherwise, click the Play button. 

To play a video file in Media Player:
1 Start Media Player.

If necessary, use the DVP installation disks to install Media Player first.
2 Choose Open from the File menu.
3 Select the file you want to play, then click OK.
4 Click the Play button.
You can also double-click an .AVI file to open Media Player and play the video. The video closes automatically 
when it stops playing.
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Sending your video to someone
Step by step

Before you distribute the video files you build in DVP, you must make sure that your audience has the appropriate
.AVI drivers installed on their hard disks, so they can play back the files. 
Note Your audience does not need special hardware to play back DVP files, but playing them on an i486 or 
Pentium system ensures that your files perform well.
The DVP installation disks include the Video for Windows Runtime Setup disk to make video file distribution easier.
This disk contains all the driver files needed to view your DVP video. You can copy the entire contents of this disk 
to another disk to include with your DVP video. You may also want to include instructions (such as the sample 
below) on how to install the files and play the video.

To install the Video for Windows runtime files:
1 Insert Video for Windows Runtime Setup into an appropriate disk drive.
2 From the File menu in the Program Manager, choose Run.
3 In the Command Line box, type b:\setup (or specify another disk drive if necessary).
4 Click OK, then follow the installation instructions onscreen.

The necessary .AVI drivers are installed along with Media Player, which lets you use the drivers to play the 
video.

To play a DVP video:
1 Copy the DVP video files to your hard disk.
2 Locate and run Media Player.
3 Choose Open from the File menu.
4 Select the file you want to play, then click OK.
5 Click the Play button.
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DVP window
Click an area of the Asymetrix Digital Video Producer window that you'd like to know more about.
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DVP Capture window
Click an area of the DVP Capture window that you'd like to know more about.



Maps of screen elements
DVP window



 Open Project
Opens an existing DVP project file. Only one project file can be open at a time. Clicking this button is the same as 
choosing Open Project from the File menu.



 Import Media 
Imports any media file (in .AVI, .BMP, .DIB, .FLI, .FLC, .GIF, .PCX, .TGA, .TIF, or .WAV format) that you want to 
include in your project. Clicking this button is the same as choosing Import Media from the File menu.



 Build
Compiles all the media clips you placed on the timeline into a video file that you can play or import into an online 
multimedia piece. When you choose options and click OK, DVP builds the video; if you need to specify compression, 
filter, or other options, do so before specifying build options. Clicking this button is the same as choosing Build from 
the Video menu.



 Play Last Built
Plays the most recently built video. This command is available only if you have built a video since you started the 
current session of DVP. Clicking this button is the same as choosing Play Last Built from the Video menu.



 Cut
Removes the selected media clip or effect from the timeline and temporarily places it on the DVP clipboard. Clicking 
this button is the same as choosing Cut from the Edit menu.



 Copy
Copies the selected media clip or effect from the Media Window or timeline and temporarily places it on the DVP 
clipboard. Clicking this button is the same as choosing Copy from the Edit menu.



 Paste
Pastes a copy of a media clip or effect onto the timeline. Clicking this button is the same as choosing Paste from the 
Edit menu.



 Zoom In
Magnifies the timeline to display it in smaller increments. Clicking this button is the same as choosing Zoom In from 
the View menu.



 Zoom Out
Reduces the view of the timeline to display it in larger increments. Clicking this button is the same as choosing Zoom 
Out from the View menu.



View Range
Displays the starting point and the number of frames to display on the timeline. You can view the current range, or 
choose a new view range. Clicking this button is the same as choosing Set Range from the View menu.



 Display Current Track Only
Displays only the timeline track that currently contains the cursor, so that you can work with the media clip on that 
track more easily. Clicking this button is the same as choosing Display Current Track Only from the View menu.



 Display All Tracks
Displays all six tracks (Video A, Video B, Trans, Overlay, Audio A, and Audio B) of the timeline simultaneously. You 
can then see how the media clips are arranged relative to one another as you work. Clicking this button is the same 
as choosing Display All Tracks from the View menu.



 Point & Click Help 
Changes cursor to a question mark with which you can click an element of DVP to get Help on it.



Transition track
Track on the timeline where you can locate transitions.



Overlay track
Track on the timeline on which you overlay images, videos, or titles.



Cut and Paste indicators
Display the current setting for the Cut/Paste option (set in the Options dialog box).



Media Window
Window in which a project's media files are stored. When you import a media file, DVP adds the file to the Media 
Window. Media files must be added to the timeline to appear in your output video.



Toolbar
Displayed across the top of the DVP main window. Provides fast mouse access to menu commands. Click the Point 
& Click button at the bottom of the toolbar, then click the button you want information about.



Tick bar
Bar that displays the current view range in frame numbers or time code.



Timeline
Six tracks used for constructing new videos. You drag clips from the Media Window or drag segments from the Player
windows and drop them onto a timeline track. You can then arrange the clips on the timeline in the way you want 
them to play in your video.



Video track
Either of two tracks (Video A or Video B) on which you can place video clips.



Audio track
Either of two tracks (Audio A or Audio B) on which you can place audio clips.



Title bar
Indicates the name of the project file that is currently open.



Menu bar
Contains all DVP commands.
To view the contents of a menu, do one of the following:

Within DVP, click the menu name with the mouse.

Within DVP, press Alt+n (the underlined letter in the menu name).



Player window
Displays videos or images that you drag into the Player. If you are playing an audio clip, the window remains dark.



Clip indicator
Highlights the segment of the clip that you have marked.



Player
Used for viewing and editing video files.



Exit button
Clears the Player and restores it to its original size. You can drag a new clip into the Player without clicking Exit; the 
previous clip clears automatically.



Video button
Plays the video in a clip without the sound.



Audio button
Plays the sound in a clip without the video.



Video And Audio button
Plays both the video and sound in a clip.



Previous Frame button
Moves the clip backward one frame.



Next Frame button
Moves the clip forward one frame.



Jump To Start button
Moves the clip to the first frame.



Jump To End button
Moves the clip to the last frame.



Jump Back button
Moves the clip back approximately 10 percent of its length.



Jump Forward button
Moves the clip forward approximately 10 percent of its length.



Play Reverse button
Plays the clip backward at normal speed.



Play button
Plays the clip forward at normal speed.



Pause button
Stops the clip at the current frame.



Frame select slider
Slides to select a specific frame.



Edit point indicator
Shows the current location of the Mark In and Mark Out points.



Mark In button
Marks the current frame as the beginning of the segment, and displays its frame number.



Mark Out button
Marks the current frame as the end of the segment, and displays its frame number.



Frame counter
Indicates the current frame number and total number of frames in the clip.



Key frame indicator
If a K is displayed, indicates that the current frame is a key frame.



Frame counters
Three status areas that indicate the current frame number and total number of frames in the clip; the Mark In and 
Mark Out points if you've edited the clip; and whether the currently displayed frame is a key frame.



 Set Capture File
Sets the location and name of the file in which to save the current captured video. Clicking this button is the same as 
choosing Set Capture File from the File menu in DVP Capture.



 Save File
Saves the current capture file to a new file. Clicking this button is the same as choosing Save Captured Video As 
from the File menu in DVP Capture.



 Preview Mode
Specifies that DVP Capture displays video frames in the preview window as they are captured. When not in Preview 
mode, DVP Capture displays single frames in the preview window. Clicking this button is the same as choosing 
Preview Mode from the Options menu in DVP Capture.



 Overlay Mode
Specifies that DVP displays the video signal as live video on your monitor, rather than as digitized video. Available 
only if your video capture board supports its own VGA monitor output; otherwise, the button is dimmed. Clicking this 
button is the same as choosing Overlay Mode in DVP Capture.



 Single Frame
Captures the current frame and displays it. You can save the captured frame using the Save Single Frame command,
or copy and paste it into another program. Clicking this button is the same as choosing Single Frame from the 
Capture menu in DVP Capture.



 Frames
Captures a series of individual frames to the capture file. Clicking this button is the same as choosing Frames from 
the Capture menu in DVP Capture.



 Video
Begins capturing the input video to the capture file, using the specified frame rate and other capture settings. Clicking
this button is the same as choosing Video from the Capture menu in DVP Capture.
Note You end a capture by pressing Esc (unless you've changed this option in the Settings dialog box).



 Palette
Creates an 8-bit palette from the colors used in your captured video. Available only if your video capture board 
supports 8-bit video. Clicking this button is the same as choosing the Palette command from the Capture menu in 
DVP Capture.



Capture preview window
Previews video from your video source.



Menu bar
Contains all DVP Capture commands.
To view the contents of a menu, do one of the following:

In DVP Capture, click the menu name with the mouse.

In DVP Capture, press Alt+n (the underlined letter in the menu name).



Load Palette
File menu (DVP Capture)

Loads a palette file you select and applies it to an 8-bit captured video.

Option Description
File Name Lists availabe palette files. Select or enter the name of a file to open. Clicking OK opens the 

selected file.
List Files Of Type Indicates .PAL as the default file extension.
Directories Displays the current directory and path. To change to another directory, select it from the 

Directories box.
Drives Lists the available drives. To change to another drive, select it from the Drives box.



Set Capture File
File menu (DVP Capture)

Toolbar:

Specifies the name and location of the file in which to save the current captured video.
Note Use the capture file for temporary storage of a captured video, as its contents are replaced without warning 
each time you capture video (unless you change the name of the capture file).To keep a captured video, use the 
Save Captured Video As command to save a permanent copy of the current capture file.

Option Description
File Name Specifies a file name of up to eight characters under which to save the captured video. The 

file is saved with the .AVI extension.
List Files Of Type Indicates .AVI as the default file extension.
Directories Displays the current directory and path. To change to another directory, select it from the 

Directories box.
Drives Lists the available drives. To change to another drive, select it from the Drives box.



Commands
Save Captured Video As (DVP Capture)
Save Palette (DVP Capture)
Save Single Frame (DVP Capture)



Allocate File Space 
File menu (DVP Capture)

Reserves space on your hard disk for storing the capture file. Allocating space can help prevent video frames from
being lost or dropped during capture.

Option Description
Free Disk Space Shows the amount of space available on the current disk drive. Change target disk drives 

by choosing Set Capture File from the File menu.
Capture File Size Shows the amount of disk space (in megabytes) to allocate for the capture file. The capture

file always uses the entire allocated space, regardless of the length or complexity of the 
video you capture, and will use more than that amount if necessary.



Commands
Save Captured Video As (DVP Capture)
Save Palette (DVP Capture)
Save Single Frame (DVP Capture)
Set Capture File (DVP Capture)



Save Captured Video As 
File menu (DVP Capture)

Toolbar:

Saves the current capture file (which you specify using the Set Capture File command) to a new file. Use this 
command to rename the current capture file, so you can capture successive clips without overwriting the original 
capture file.

Option Description
File Name Specifies a file name of up to eight characters under which to save the captured video. The 

file is saved with the .AVI extension.
List Files Of Type Indicates .AVI as the default file extension.
Directories Displays the current directory and path. To change to another directory, select it from the 

Directories box.
Drives Lists the available drives. To change to another drive, select it from the Drives box.



Commands
Save Palette (DVP Capture)
Save Single Frame (DVP Capture)
Set Capture File (DVP Capture)



Save Palette 
File menu (DVP Capture)

Saves the current palette from an 8-bit captured video.
This command is available only if your capture board supports 8-bit video, and you have set it to capture video in 
8-bit format. You specify the format of a video capture by using the Video Format command.

Option Description
File Name Specifies a file name of up to eight characters under which to save the current palette. The 

file is saved with the .PAL extension.
List Files Of Type Indicates .PAL as the default file extension.
Directories Displays the current directory and path. To change to another directory, select it from the 

Directories box.
Drives Lists the available drives. To change to another drive, select it from the Drives box.



Commands
Save Captured Video As (DVP Capture)
Save Single Frame (DVP Capture)
Video Format
Concepts
About color palettes



Save Single Frame
File menu (DVP Capture)

Saves the frame that is currently playing as a bitmap file with the file name, extension (.BMP or .DIB), and location 
you specify.

The bitmap file you save has the same bit depth as the video from which it was captured. To change the captured 
video's bit depth, use the Video Format command.

Option Description
File Name Specifies a file name of up to eight characters under which to save the current frame. The 

file is saved with a .BMP or .DIB extension.
List Files Of Type Indicates .BMP as the default file extension. You can also specify .DIB as the file extension.
Directories Displays the current directory and path. To change to another directory, select it from the 

Directories box.
Drives Lists the available drives. To change to another drive, select it from the Drives box.



Commands
Save Captured Video As (DVP Capture)
Save Palette (DVP Capture)



Exit 
File menu (DVP Capture)

Closes DVP Capture. If you opened DVP Capture from within Asymetrix Digital Video Producer, Exit returns to 
DVP, where the captured video is placed in the Media Window.



Copy 
Edit menu (DVP Capture)

Copies the currently captured frame and its palette to the Windows Clipboard.



Paste Palette 
Edit menu (DVP Capture)

Pastes the palette that is currently on the Windows Clipboard into DVP Capture, which applies it to the next 8-bit 
video that you capture.
Any 8-bit palette that can be copied to the Windows Clipboard can be pasted into DVP Capture. For example, you 
can paste a palette from any 8-bit bitmap: simply open a bitmap in a bitmap-editing program, copy it to the 
Clipboard, switch to DVP Capture, and then paste the palette using the Paste Palette command.
This command is unavailable if your capture board does not support 8-bit video, or if the Windows Clipboard does 
not currently contain a palette.



Audio Format 
Options menu (DVP Capture)

Sets the size, channel, and frequency formats for audio to capture. In general, you should capture audio at the 
lowest acceptable level of quality. While higher-quality audio sounds better, capturing it successfully is more 
demanding for your hardware and increases file size.

Option Description
Sample Size Sets the amount of data in each sample. Audio sampled at 16 bits sounds better, but produces

larger files.
Channels Sets the channel, Mono or Stereo. Mono plays the same audio through both speakers, while 

stereo has two separate channels.
Frequency Number of audio samples per second, expressed in Hertz (Hz), in the audio file. The higher 

the frequency, the better the sound quality.



Concepts
About sound



Video Format 
Options menu (DVP Capture)

Specifies the frame size and other settings that are supported by your capture board for a video capture. Common
settings are shown below, however, refer to your video capture board documentation for specific setting 
information:

Resolution

Frame size

Image size

Compression

Bit depth

Key frames



Video Source 
Options menu (DVP Capture)

Displays settings for the video signal from your capture board. If your video capture board does not support these 
features, the command is dimmed. The specific settings available in this dialog box depend on the type of video 
capture board you have installed. Common settings are shown below, however, refer to your video capture board 
documentation for specific setting information.

Option Description
Video Signal Type If your capture board supports different video signal types, sets the signal type to use: 

Composite video, S-Video, or RGB video input.
Video Standard Depending on the standards your board supports, sets the standard as NTSC 

(American), PAL (European), or SECAM.
Real-Time Filters Sets real-time filters to use, such as tint, contrast, and brightness.



Video Display 
Options menu (DVP Capture)

Displays settings for your capture board's video signal and options for monitoring the video capture. This 
command is available only if your video capture board supports its own VGA monitor output; otherwise, the 
command is dimmed. The available settings depend on the kind of video capture board you have installed. 
Common settings are shown below, however, refer to your video capture board documentation for specific setting 
information.

Option Description
Input/Capture Toggles between monitoring the video input signal and monitoring the actual captured frames.
Filters Specifies video filters for the monitor.



Compression 
Options menu (DVP Capture)

Compresses the captured video using a codec you select, according to quality options you specify. 
For best results, use this command to compress video that you're capturing on an MCI-controllable device 
Otherwise, do not use this command and instead. Instead, use the hardware-assisted compression available 
through the Video Format command.
Note Using software-based compression during capture requires extensive computer processing power. Often, 
frames are dropped so the system can keep pace with the video capture. Using hardware-assisted compression, 
your video capture board handles more of the work, so you get better results.
Available settings will vary depending on the compressors provided with your video capture board. You may need 
to experiment to determine how the options affect video capture when used with other DVP Capture options. For 
details, refer to your video capture board documentation.

Option Description
Compressor Lists compressor/decompressor routines, called codecs, that come with DVP or with 

your video capture board.
Compression Quality Controls the balance between quality and file size. Higher-quality output videos require 

larger files, and may take longer to compress.
Key Frame Specifies how often key frames are inserted in the video. In general, choosing one key 

frame for every 15 frames provides a good balance between quality and performance.
Configure If available, provides additional configuration settings for the selected compressor.



Preview Mode 
Options menu (DVP Capture)

Toolbar:

Previews video frames in the preview window as they are captured. When unchecked, DVP Capture previews 
single frames in the preview window.



Overlay Mode 
Options menu (DVP Capture)

Toolbar:

Displays the video signal as live motion video on your monitor, rather than as digitized video. Available only if your 
video capture board supports its own VGA monitor output; otherwise, the command is dimmed.



Single Frame 
Capture menu (DVP Capture)

Toolbar:

Captures the current frame and displays it. You can then save the captured frame using the Save Single Frame 
command, or copy it and then paste it into another program.



Frames 
Capture menu (DVP Capture)

Toolbar:

Captures a series of individual frames to the capture file.

Option Description
Capture Adds the current frame to the capture file.
Done Ends the capture.



Commands
Set Capture File



Video 
Capture menu (DVP Capture)

Toolbar:

Captures the input video to the capture file, using the frame rate and other capture settings you specify. You end a 
capture by pressing Esc.
Tip Using the Settings dialog box, you can set the Esc key, left-mouse button, or right-mouse button to end video 
capture.



Palette 
Capture menu (DVP Capture)

Toolbar:

Creates an 8-bit palette based on the colors used most often in your captured video by scanning the number of 
colors and frames. DVP applies this palette to all the 8-bit video you capture, until you either create another new 
palette, load a palette, or exit DVP Capture. 
You can save a captured palette and use it with other videos using the Save Palette command.
Note This command is available only if your video capture board supports 8-bit video.

Option Description
Colors Specifies the number of colors for the palette. The default is 236 colors, which allows Windows to 

use its 20 reserved colors.
Frames Specifies the number of frames to sample to build the palette. Sampling 10 to 30 frames can 

produce a palette that doesn't contain substantial changes in color.

Tip If your video source displays many color shifts, choose a segment of video for which to create a palette 
carefully, as the palette will be applied to all the video that you capture at 8 bits. Because DVP Capture applies the
new captured palette to the source video, you can preview the palette's effect in the preview window. To do so, 
check Preview Mode on the Options menu, then select either 8-Bit Palettized or 8-Bit Dithered for the video format
(choose Video Format from the Options menu).



Settings 
Capture menu (DVP Capture)

Sets how video is captured.

Option Description
Frame Rate Specifies the number of frames per second (fps) to capture. 

Note A rate of 30 fps is equivalent to the American television 
frame rate. The default rate of 15 fps is the maximum that Video 
for Windows can play on a system without a video capture board
installed. A frame rate under 15 fps tends to create jerky motion, 
depending on the action in the source video.

Enable Capture Time 
Limit

Specifies a time limit (in seconds) for the capture.

Capture To Memory Stores as many captured frames as possible in memory. When 
all available memory is used, DVP Capture begins storing 
captured frames on the hard disk.

Capture To Disk Stores captured frames on the hard disk. Capturing to disk takes
longer than capturing to memory and so is better suited for video
with a small frame size or low frame rate.

Escape Key Specifies that the Esc key ends video capture.
Left Mouse Button Specifies that the left mouse button ends video capture.
Right Mouse Button Specifies that the right mouse button ends video capture.
Enable MCI Capture For an MCI-controllable device, specifies to use the Media 

Control Interface (MCI) for video device control. Available only if 
an MCI device driver is installed on your system.

Capture Audio Captures audio with the video. When unchecked, no audio is 
captured.

MCI Settings Opens the MCI Capture dialog box, in which you specify options 
for capturing video using an MCI video device. Available only if 
an MCI device is installed on your system.



Technical support contact information
Step by step

Telephone support
Use the following Asymetrix technical support telephone numbers as needed for your location.

Australia/Asia Pacific

    Infotainment Asia Pacific Pty Ltd.
(61+3) 5255-471 (direct)
(61+3) 5255-482 (fax)

9 a.m. to 6 p.m. Eastern Standard Time

    XLTECH Pty Ltd.
(61+2) 9752-111 (direct)
(61+2) 9752-167 (fax)

9 a.m. to 6 p.m. Eastern Standard Time

Europe (except France, Germany, and United Kingdom); Middle East; Africa; 
Russia

+44 923-208-433 9:00 to 17:00 GMT

France
05-90-83-19 (freephone) 9:00 to 17:00 GMT

Germany
01-30-81-27-07 (freephone) 9:00 to 17:00 GMT

United Kingdom
0800-716-957 (freephone) 9:00 to 17:00 GMT

U.S.A. and rest of world
206-637-1600 (direct)
206-454-0672 (fax)

6 a.m. to 6 p.m. Pacific time Monday through Thursday; 6
a.m. to 3 p.m. Friday

Online services
Asymetrix provides complimentary support via Asymetrix Bulletin Board System (BBS), CompuServe, America 
Online, and Internet to registered users. Technical support responds to online queries within 48 hours (Monday 
through Friday).

Asymetrix BBS
Do one of the following:

If you have a 1200 to 14,400 baud modem (v.32bis), call (206)-451-1173.

If you have a 9600 to 14,400 baud modem (v.32bis), call (206)-451-8290.
America Online
Do one of the following:

From the Go To menu, select Keyword, then type Asymetrix.

Go to the Computing and Software area, select Industry Connection, then select Asymetrix.
CompuServe
To connect to

Windows Third Party Developer A forum, Section 1, type GO ASYMETRIX or GO WINAPA at the prompt.

Multimedia Vendors forum, Section 15, type GO MULTIVEN at the prompt.



IBM Ultimedia Tools A forum, Section 5, type GO ULTIATOOLS at the prompt.
Internet
Enter one of the following addresses:

techsup@asymetrix.com

support@asymetrix.com




